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Chapter 1 Software Installation & Hardware Setting 

1.1 Installing the Win-GRAF Workbench 

Before installing the Win-GRAF Workbench, check the installation environment on your PC.  
 

System requirements: 

 O.S.: Windows XP, Windows Vista, Windows 7, Windows 8 (32-bits or 64-bits) 

 Microsoft .Net Framework 3.5    (Download it on the Microsoft web site: 

http://www.microsoft.com/zh-tw/download/details.aspx?id=22) 

 RAM: 1 GB minimum (Recommended: 2 GB or more) 

 Available hard-disk space:  200 MB minimum  

 
 
Installation Steps: 

1. Double-click  the “Win-GRAF-setup-ver-x.xx.exe” file in the Win-GRAF installation CD to begin the 

process.  

 
 
 
 
 

2. Click “Next” to continue and then select “I accept the agreement”, then click “Next” to continue. 

 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

http://www.microsoft.com/zh-tw/download/details.aspx?id=22
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3. Recommend to use the default installation path (i.e., “C:\Win-GRAF”) and then click “Next” to 

continue. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

4. Click “Next” to add a “Win-GRAF” folder shortcut in the “Start” menu, and then select  “Create a 

desktop icon” to add a desktop  shortcut, then click “Next” to continue. 
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5. Click “Install” to begin installing the Win-GRAF Workbench. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

6. Before the end of the installation, you will see a pop up window and it displays: 

a. The legal Win-GRAF Workbench is delivered with a legal Win-GRAF Dongle distributed by ICP DAS. 

Please always plug the Win-GRAF Dongle in your PC while running it. 

b. To run the Win-GRAF, require Microsoft “.Net FrameWork 3.5” installed in your PC. 
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7. By now, you have completed the Win-GRAF installation, then click “Finish” to exit this window. 

(Select “Launch Win-GRAF” to auto-run the Win-GRAF after completing the setup. If there is no 

Win-GRAF Dongle in your PC, the Win-GRAF Workbench will run in Demo mode.) 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

1.2 Run the Win-GRAF Workbench 

Before running the Win-GRAF Workbench, make sure the Win-GRAF Dongle is plugged into your PC.  
 
 
 
 
 
 
 
 
 
 
Description of the “Win-GRAF” folder: 

Libraries:  For users to create their own function or modify an exist function. 

Handbook: The manual details the software interface, programming environment, programming 

languages, and so on, provided by COPALP.  

(Or click the [Help] > [Topics] from the Win-GRAF menu bar) 

History:  The modification history and features added of the Win-GRAF Workbench.  

Manual:  The Win-GRAF manual provided by ICP DAS. 

(Or click the [Help] > [Tutorials] from the Win-GRAF menu bar,  

the manual is located in the path “C:\Win-GRAF\Tutorials”) 

ReadMe: The notice for the Win-GRAF Workbench. 
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1.2.1 Win-GRAF Operating Mode 

 The Win-GRAF Workbench provides two operating modes: 

“Demo Mode”: Without using a Win-GRAF Dongle. The compiled Win-GRAF project can run for 15 

minutes in the PAC. Once the time limit has expired, users must Stop/Start this 

project again and it only supports up to 40 I/O tags. 

“Large Mode”: Using a Win-GRAF Dongle. The project can run in the PAC without the time limit.   

 
Demo Mode - Without using a Win-GRAF Dongle. 

The start screen will show as below after running the Win-GRAF Workbench. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Note: If you install the Win-GRAF Dongle in the Demo Mode, you must close Win-GRAF Workbench and 

then start it again to make it become Large Mode. 
 
Large Mode - Using a Win-GRAF Dongle. 
The start screen will show as below after running the Win-GRAF Workbench. 
 
 
 
 
 
 
 
 
 
 
 

No Win-GRAF Dongle found. Demo mode! 

It describes the limitations in 
demo mode, you can also 
click the main menu [Help] > 
[About] to see this content. 
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1.2.2 Win-GRAF Operating Environment 

Run the Win-GRAF and then the main screen will show as below: 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Note: Mouse right-click on the top of the Window to Show/Hide the menu bar. 
 

A. The Workspace:   It allows users to create project lists, and add/open the Win-GRAF program as 

well as the related settings. Moreover, the new project can be created by using a 

project template. 

B. The Program Area: It used to show/edit the program and can be divided into more function area.  

(Refer the Section 2.2.1) 

C. The Message Area:  It used to show compiler messages and provides more diagnostic tools. 

 

Tips:   
1. To resize a window, click and drag the side or corner of the window to change its size. 

2. Press the “F1” key to open the user manual  (i.e., HTML Help). 

 
Hind or Show the window 
If you carelessly closed the Variables pane or the Message Area during the programming, you can click 

the menu bar "View" and select the following options to open this window again.  

 
 
 
 
 
 

Output:  It means the Message Area. 

Infos Tab1: It means the Program Area – Variables pane (refer the Section 2.2.1).  

Infos Tab2: It means the Program Area - Function Blocks pane (refer the Section 2.2.1).  

 

Workspace 
 

A 

Program Area 
 

B 

Message Area 
 

C 

Menu / Tool bar 
Right-click 
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1.2.3 Win-GRAF Library Manager 

Win-GRAF Workbench provides a Library Manager that can be used to look up all descriptions for 

Functions, Function Blocks and I/O Boards.  

 
1. To begin this, click the Start button and click "All Programs" > "Win-GRAF" > "Libraries" > “OEM”.  
 
 
 
 
 
 
 
 
 
2. In the “Library Manager” window, click the menu bar “File” > “Open Library” and select  “ICP DAS – 

XP-WP-VP” then click “OK”.  

3. Select any title in the “Function and FBs” tab and click the “Description” to view the usage of this 

Function or Function Block; Select any title in the “I/Os” tab and click the “Description” to view the 

usage of this I/O Boards.  
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1.3 Setting the Win-GRAF PAC’s IP Address 

For connecting with the PAC, the Win-GRAF Workbench needs to know the PAC IP. The following will 
show you how to set up the PAC IP. Using the XPAC (XP-8xx8, XP-8xx8-CE6, XP-8xx8-Atom-CE6) and the 
WinPAC (WP-8xx8, WP-5xx8) as the example: 
 
Hardware Wiring Diagram 
 
 
 
 
 
 
 
 
 
 
PAC Side 

Using the USB mouse that connected to the PAC, and click “Start” > “Settings” > “Network and Dial-up 

Connections” on the lower left corner of the monitor, then double-click the “LAN1” (or LAN2), then fill in 

a proper IP address. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 
 

1 

2 

3 

Click to use the keyboard  
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Open the “WinPAC_Utility.exe” (or “XPAC_Utility.exe”) on the desktop (or \System Disk\tools\).Then, 

click   “File” > “Save and Reboot” to reboot the PAC. 

 
Notice:  

For connecting properly, the PC/Win-GRAF IP and the PAC IP must in the same network segment. 

For example, set the PC’s IP to “192.168.1.20” (Mask: 255.255.255.0). 
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Chapter 2 A Simple Win-GRAF Program 

2.1 Creating a New Win-GRAF Project 

The following sections will introduce you to a simple template project that used to get/set (read/write) 

the Win-GRAF PAC‘s system time. Follow the steps below to complete this demo program. 

 

2.1.1 Creating a template project (Demo01) 

1. Run the Win-GRAF Workbench (refer the Section 1.2), and click "File / Add New Project..." from the 

menu bar. 

 
 
 
 
 
 
 
 
 

2. Click “From template” to create a project from a template, enter a project name (e.g., "Demo01") in 

the Name field and add a simple note in the Comment field, then click "Next". By default, it will 

show a "ICPDAS_template" option provided by Win-GRAF Workbench, just click "Next" to continue. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Recommend to use the default folder. 
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3. Now, you have created the “Demo01” template project. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Note:   In the demo01, we use a “From template” way to create this project. If you select "Project" in the 

step2, click the "Release" in the “Compiling options" setting. The others setting can be done in 

the following sections, just click "Next" and then "OK" button to end the settings.  

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

“PAC IP:502”, 
See Section 2.3.5 
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2.1.2 Important project settings 

There are two important settings must be done after creating the project.  

1. In the "Workspace", mouse right-click the project name (e.g., "Demo01") and then uncheck the  

"Alphanumeric Sorting" option (the last one). If unchecked, means the programs are in execution 

order ; If checked, means the programs are in alphanumeric order (e.g., FBD1, LD1, ST1). 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Change the execution order of programs: 

Note:  If you want to change the execution order of programs, mouse right-click the project name 

(e.g., "Demo01") and click "Cycle" (as the screenshot above) to open the settings window, 

then click the "Move Up" or "Move Down" button to change the order. 

 
 
 
 
 
 
 
 
 

2. If using the "Project" way to create a new project (in this example, we use the “From template” way, 

refer the Section 2.1.1 - Step 2), click the"Project" > "Settings..." from the menu bar to open the 

"Project settings" window. Click the "General" option and set the "Complex variables in a separate 

segment" to "Yes" to allow the using of complex data structures, such as arrays. Finally, click "OK" to 

exit the window.  

 

 

 
 
 
 
 
 
 
 
 

Checked,  
In alphanumeric order 

Right-click 

 
 
 
 
 
 
 
 
 

Unchecked, 
In execution order 
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(Note: The "Code Generation" must be set to "Release".) 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



Win-GRAF User Manual,  V 1.00,  Jul. 2014  by ICP DAS     2-5 

 

2.2 Introduction of the Project  

2.2.1 Demo01 - LD Program 

This program is used to read/write the Win-GRAF PAC‘s system time. In the Workspace, double-click the 

LD program name (i.e., “PAC_Time") to open all relevant windows. As the screenshot below, the 

Program Area has three main parts: 

 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Tips:   Mouse click the Program Editor Area, and press the  "+“  or “-” key to zoom in or zoom out the 

content. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
A. Program Editor Area (LD):   

This area allows to edit or display this LD program, you can click the object button (on the left of 

Program Area) to add a program, and then drag-and-drop variables (in the Variables Area) onto the 

function block one-by-one.  

 
 

(E.g., press "-” key twice to 
zoom out the content.) 

A. Program Editor 
Area (LD) 

B. Variables 
Area 

C. Function 
Blocks Area Note:   , means the 

program is locked and 
cannot be deleted. 

Program Area 
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B. Variables Area: 

This area shows the function blocks and variables that used in this program. Mouse double-click the 

“Name” or “Type” item to modify its name or data type, then click “Enter” to complete the setting. 

(Refer the Section 2.3.1 for the details about variable declaration.)  

 

Note:  For the function block can work correctly, the 

“Inst_xxx..” FB instance variable will be automatically 

added when using one function block. For the safety 

reasons, this FB instance variable will not be automatically 

deleted even if the function block has been removed in the 

editor area. So, users can right-click the unwanted variable 

and select “Clear” to manually remove it.  

 

 
 
 
 
 
 
 

C. Function Blocks Area: 
In the “Blocks” tab, it provides many types of the function block for users to drag and drop them to 
the editor area.  

 
 
 
 
 
 

 
 

 

R1: Get current time of the PAC R2: Set “Set_new_time” to “True”  to set the new time 

R3: Reset it to “False” 

Tips:  
After selecting the function 
block, press “F1” key to open 
the HTML Help. 

FB instance variable 
variable 
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2.2.2 Demo01 - Variables 

In the workspace, mouse double-click the “Variables” item to open the Variables window. The following 

screenshot shows all the needed and defined variables in this “Demo01” project. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

Tips:   In the Variables window, users can click any title field (e.g., “Name”) for sorting.  

If you want to go back to the original sort order, mouse right-click anywhere and select the 

“Cancel Sorting” option. 

 
 
 
 

 
 
Field description:  (Press the “F1” key to  look up the details)  

Mouse double-click any field item to set or modify the data. 
 

Name:  A valid variable name starts with a letter (e.g., "A to Z" or "a to z") followed by any 

number of letters, numbers (e.g., "0 to 9"), or an underscore (i.e., “_”). 

Type:  Data type. (Refer the Appendix A for the value range) 

Dim.:  To specify the range of an array. 

(E.g., enter “10”, means the use of the Counter [0] to [9]). 

Attrib.:  Double-click this field item to set it to “Read Olny” that means users can only read this 

variable but cannot modify it. 

Syb.:  If checked, the variable name will also be downloaded into the PAC. 

Init value:  To set the initial value of the variable. 

User Group:  All the variables can be divided into some groups (e.g., “Group1”, “Group2”) and it is 

convenient for users to look up or search these variables. 

Tag: To enter a nickname for the variable. 

Description: To enter a simple note for the variable. 

 
 
 
 
 

Click it to sort by name. 
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2.3 Give it a Try 

As mentioned before, we have described the LD program (Section 2.2.1) and variables (Section 2.2.2) in 

the "Demo01” project. The following sections will show you how to declare variables and add an LD 

program with the blinking function in this project.  

 

2.3.1 Declaring the Win-GRAF Project Variables 

First, we will declare two boolean variables (i.e., "LED1" and "LED2") that used in the program. 

1. In the “Variables” window, mouse right-click any item in the “Name” field and select “Add Variable”  

(or press the "Ins" key or click the   tool button) to add a variable. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

2. Double-click the new “NewVar” item and change its name to “LED1”, then click “Enter” to finish the 

setting. In this case, the data type is "BOOL".  

 
   
 
 

Note:  The settings will be done only after clicking the “Enter” key. 
 

3. Follow the previous steps to add the “LED2”  boolean variable. 

 
 
 
 
 
 

Tips:  To set up multiple ordinal variables, enter the name “LED” (as the step2) and then press “Ctrl+C” 

and “Ctrl+V” twice to create “LED1” and “LED2” (auto sequential numbering), finally, delete the 

first variable (i.e., “LED”).  
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Tip #2:   
1. If you need to add multiple variables (e.g., “Boo_01 to Boo_16”), simply right-click the “Global 

variables” and select the “Add Multi Variables”.  

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
2. Follow the settings like the figure below (Name:  “Bool_%%”; Type:  “BOOL”; From: 1; To: 16) to 

create Boolean variables (i.e., “Bool_01” to “Boo_16”) and then click “Create all” button to complete 

the settings.  

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Mouse right-click 
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2.3.2 Declaring the I/O Variables 

In this example, the I-8055W module that used to show the blinking feature must be plugged in the 

PAC‘s slot1. So, we need to add an I/O link to correspond to the real I/O module.  

 

1. Click the "Open I/Os" tool button to add an I/O link. 

 
 
 
 
 

2. Mouse double-click on "Slot 1” and then double-click the "i_8055" to select this I/O board. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

3. Click the “Close” button to exit the “I/O Boards” window. 
Note: Click the “Virtual/Real” button to change to the Virtual l/O (for testing) or the Real I/O. 

(The Real I/O is used in this example).  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Virtual I/O:  (It shows in blue) 
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After linking the “i_8055” I/O board, it will automatically add 8 input & output variables in the 
“Variables” window. 
 

 
 
 

%IX1.0 – i_8055_DI  
“I” means “Input” 

“X” means “Boolean” 

“1” means “Slot 1” 

%QX1.1 – i_8055_DO 

“Q” means “Output” 

“X” means “Boolean” 

“1” means “Slot 1” 
 

%ID   or  %QD 

“D” means “Integer/Real” 

 

 
There are three output variables are used in this example, and you can modify the name for easy use. 

Mouse double-click the item and fill in a name, then press “Enter” key to finish the setting.  

 
 
 
 
 
 
 
 
 
 
 
 



Win-GRAF User Manual,  V 1.00,  Jul. 2014  by ICP DAS     2-12 

 

2.3.3 Creating an LD Program 

In the “Demo01” project,  we want to create a “LD1” program to show the blinking. To begin, follow 

these steps: 

1. In the workspace, mouse right-click the “Programs” folder and select “Insert New Program…”. 

 

 
 
 
 
 
 
 
 
 
 

2. Fill in a program name in the “Name” field and enter a simple note in the “Description” field, and 

then select the “LD – Ladder Diagram” as the programming language and click the “OK” button.  

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

3. Double-click the “LD1” program to open the editor window. 
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4. Click the  “Insert FB..” button on the left of the “LD1” window to add a function block.  

 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

5. Double-click this function block and select the “BLINK”, then 

click the “OK” button. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Tips:   
You can also drag and drop 
the “BLINK” function block 
into the “LD1” window. 

Tips:  (Refer Section 2.2.1 – B) 
Click the upper area, to change a FB instance variable. 
Click the lower area, to change a function block. 

Tips:   
You can press the “BL” key 
to quickly find out the name.  
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Important Notice: 

 
When programming, users may copy & paste an existing function block to create a new one. But, 
this way will cause a function exception due to the same function instances. Therefore, users must 
create a new name for the function instance.  
 
1. Mouse double-click the function block and enter a new name (e.g., “Inst_BLINK1”), then click the 

  button to complete the setting.  

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
2. In the “Inst_BLINK1” window, click “Yes” to create this function instance.  
 
 
 
 
 
 
 
 
 
 
 
3. Now, there is an “Inst_BLINK1” function instance added in the Variables Area.  
 
 
 
 
 
 
 
 
 
 

 
 

2 

3 

Tips:   
You can also use the same way to 
double-click  on the right-side of the 
“Coil” to create or assign a variable.  
(See Step7) 

1 
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6. Click the “Coil” on the right of the “BLINK” function block, and continuously click the “Insert Coil” 

button to add four “Coil”. 

 
 
 
 
 
 
 
 
 

 
 
 
 
 
 
 

7. Mouse double-click the first “Coil” and double-click “LED1” to assign it. Follow the same way to 

assign the “LED2” variable to the second “Coil”. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

8. As the screenshot below, mouse drag-and-drop the “Output1”, “Output2” and “Output3” variables 

to the 3th, 4th and 5th “Coil”. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 

1 

2 

Tips:  press the “+”  key to zoom in the content.  
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9. Mouse double-click on the left of the “CYCLE” and enter “T#2S”  (to blink every two seconds), and 

then click    to finish the setting. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

10. Finally, click the “Save” button to save the “LD1” program. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

Note:  “ ”  means this program is opened (locked, cannot be deleted). Click the “X” in upper-right 

corner of window to close this program (un-locked, “ ”).  
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If you want to add a program to the first line after completing the programming, follow these steps: 
 

1. Click the upper-left corner of the Program Editor Area, and you will see the selectable items on the 

Object bar. Select an object (4 to 7, as the screenshot below) to add a program to the first line.  

Note: You can also select an object (1 to 3) to add it on the left of the current program.   

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

2. In this case, click “Insert new rung” to add it to the first line. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Add a object on the left of the program: 
4. Insert jump (shift + F9) 
5. Insert Coil (F9) 
6. Insert new rung 
7. Insert commecnt line 

Add a object on the left of the current program: 
1. Insert contact before (shift + F4) 
2. Insert horizontal line (shift + space) 
3. Insert FB before (shift + F8) 
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2.3.4 Compiling the Program 

In the previous section, we have added and saved the LD program. For the Win-GRAF project can 

function properly in the PAC, we need to compile the programs. To begin, follow these steps: 

 
1. On the menu bar, click “Project > Build All Projects” to compile all programs. 

 
 
 
 
 
 
 
 
 

2. If a “No error detected” message is appear that means the project was successfully compiled. 

Note:  If you modify and save the program after compiling it, click the “Clean All Projects” to clean 

the previous results and then do the step1 again.   

 

 
 
 
 
 
 
 
 
 
 
 
 

If the Win-GRAF is running in Demo 
Mode, this message means the 
Win-GRAF project can run for up to 
15 minutes in the PAC. 

Check to see if there is any 
error message here. 
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2.3.5 Download the Program to PAC 

Before downloading the program, you need to set up the communication parameters. (By now, it only 
supports the Ethernet TCP/IP). 
 
1. Mouse right-click the project name (i.e., "Demo01") and select “Communication Parameters…” to 

open the settings window. 

 
 
 
 
 
 
 
 
 
 
2. Enter the “PAC IP:502” (e.g., “192.168.255.1:502”) to add an IP address and then click “OK”. 

It can also click the    button to add/modify the IP address. 

 (Note: the default PAC IP is “192.168.255.1” and the fixed port number of Win-GRAF PAC is “502”) 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
 
 
 
3. Before establishing a connection, make sure the PAC and the network are working properly.  

 

Tips:  All the configured IP will be listed here. You 
can select the unwanted IP and press “Del” key to 
delete it (e.g., “192.168.78.8: 502”). 
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4. Click the menu bar “Project” and select “On Line”, or click the  tool button to establish a 
connection. 

 
 
 
 
 
 

 
 
 
 
 
5. As the screenshot, if it shows “App: TEST”, different to the current project name (i.e., “Demo01”), 

that means there is a project (name: “TEST”) running in the PAC. Click “Stop application” tool button 

to stop the “TEST” project. 

 
 
 
 

 
6. Click the “Download” tool button to download the “Demo01” project. 

 
 
 
 
 

 
 
 
 

7. If it shows “RUN” that means the "Demo01" project is successfully running in the PAC.  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

It shows the current 
time of the PAC. 
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Note:   If there is any error message show up during the download process, refer the Appendix B to get 
the solution. 

 
Cycle time 
When on-line with the PAC, move your mouse over the “RUN” position on the toolbar to view the 

current cycle time of the program in the PAC. You can also view the cycle time in the bottom-right 

corner of the message area.  

 

 
 

When doing the “On Line” ( ) operation, it will automatically switch to the “Runtime” tab and you 

can see if there is any error message for the downloaded program. (E.g., in this example, we need to 

plug the I-8055W module in the Slot1 of the PAC, and the message “Board error in the slot No. 1 !” 

means there is no I/O module in the Slot1 or an I/O exception.)  

 
Shutting down the PAC, and plug one I-8055W module in the PAC’s  Slot1 then reboots. Then, click 

“On Line” ( ) button to connect to the PAC. 
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2.3.6 Testing the Program 

In the previous section, you have successfully downloaded the “Demo01” project and the following will 

describe how to test the program. 
 

The “PAC_Time” Program: 
1. Mouse double-click the variable name (e.g., “new_Year”) in the “TIME_SET” function block (or the 

Variables Area) one-by-one to change the PAC’s system time (e.g., to change it as January 1, 2015 

12:30:35). 

 
  

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
2. Set the “Set_new_time” variable to “TRUE” to write the new system time. 
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3. Then, the new system time will show on the “TIME_GET” function block (or the Variables Area), 
and the “Set_new_time” variable will be reset to “FALSE” automatically. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
The “LD1” program: 
4. When the “Demo01” project is running, you can check to see if the DO0, DO1 and DO2 tags of the 

I-8055W I/O module that plugged in the slot1 of the PAC is blinking every two seconds (like the 

value "T#2S” we set before).  You can also assign a “TIME” variable on the left side of the “CYCLE” 

for easy to change the time setting. Refer the Section 2.3.1 for the setting way. 

5. If the “%QX1.1.3” variable is set to “TURE” in the Variable Area, the LED4 (i.e., “DO3”, at the top of 

the I-8055W I/O module) will light up. 

 

 
 
 
 
 

 
 
 
 
 
 
 
 
 
 

6. Click the    tool button again to cancel the PAC connection.  
Note:  Do NOT click the “Stop Application” button; it will stop the running project in the PAC. 

新設定的 PAC 系統時間。 

顯示 PAC 系統時間。 
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Chapter 3 Modbus Slave: Allow the SCADA/HMI Software to 
Access Win-GRAF Variables 

In Chapter2, we have described how to get/set the PAC system time (i.e., the “PAC_Time” program) and 

create a blinking function (i.e., the “LD1” program) in the “Demo01” project. The following sections 

describe how to allow the SCADA/HMI software (e.g., “InduSoft”) to access Win-GRAF variables that 

defined in the "Demo01" project. The Win-GRAF Workbench provides two ways to open the PAC data, 

one way is to enable the Win-GRAF PAC as a Modbus TCP Slave and the second way is to enable the 

Win-GRAF PAC as a Modbus RTU Slave (you must first complete all the Modbus Slave settings in Section 

3.1, and then refer the Section 3.2). To begin, follow these steps: 
 

3.1 To Enable the Win-GRAF PAC as a Modbus TCP Slave 

1. Click the “Open Fieldbus Configuration” tool button to open the “IO Drivers” window. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

2. Click the “Insert Configuration” button on the left side of the “IO Drivers” window and then select the 

“MOSBUS Slave” and click “OK” to enable a Modbus TCP Slave. 

 
 
 
 
 
 
 
 
 
 
 
 
 

http://www.icpdas.com/products/Software/InduSoft/indusoft_tc.htm
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3. Click the “Insert Master/Port” button on the left side to set the “Slave number” (In this case, the 

value is “1”), and click the “OK” button. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
4. Click the “Insert Slave/Data Block” button on the left side to open the “MODBUS Slave Request” 

window. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
5. Enter a simple note in the “Description” 

field and then click the "Input Registers” 

option. 
 

For Modbus Master to Read data: 

Options Data types 

Input-bits BOOL 

Input Registers 
BYTE, INT, DINT, 
REAL, etc. 

 

For Modbus Master to Write data: 

Options Data types 

Coil-bits BOOL 

Holding 
Registers 

BYTE, INT, DINT, 
REAL, etc. 

(Refer the Appendix A to see more data type) 
 

Tips:   
1.  Press the “F1” key to open the Help on this subject. 
2.  If you add two or more “Server - …” settings, type a 

“Server ID” for easier use (a string, e.g., `SVR1’) 

Enter a simple note. 

Recommend to set 
“Base address” to “1” 
and set the value of 
“Nb items” is greater 
than “200”.  
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6. As the screenshot above, it’s recommended to set the “Base address” to “1” and the “Nb items” 

refers to how much variable data can be provided by one “Data block”. If the data address requested 

from the Modbus Master (e.g., the SCADA software) is greater than this value (in this example, the 

value is “2000”), the Modbus Slave (i.e., Win-GRAF PAC) will not respond.  

7. Mouse drags all the needed variables (e.g., “PAC_xxx”, data type: “DINT”) one-by-one from the 

Variables area and then drop it to the “Symbol” field.  

 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
8. Mouse double-click the “Offset” field and fill in a value, then press “Enter” key to finish the setting. 

Note:  (1) The “Offset” value starts at “0” and the Modbus address of variable is equal to this value 

      plus 1 (Base address). 

(2) If using a 32-bits (or more than 32-bits) data type (e.g., “DINT”, refer the Appendix A), it 

     requires two Modbus addresses, as the table below, the “Offset” values are 0, 2, 4, 6, etc.   

     

 
 
 

 
 
 
 
 

Tips:  
Mouse click the “Offset” field and press the keyboard “Ctrl+A” to select all items, and then click the 
“Iterate Property” button at the left-side to open the settings window.  
 
 
 
 
 
 
 
 
 
 

Enter 

Ctrl+A 



Win-GRAF User Manual,  V 1.00,  Jul. 2014  by ICP DAS     3-4 

 

Keep the “Name” setting, enter “0” into “From” field and enter “2” into “By” field, then click “OK”. 
 

(If setting the “Name” to “%%”, it will show “00, 22, 
44, 66, 88, 1010, 1212” in this example. To modify it 
depends on the required settings and then check 
the value in the “Results” area.) 

 
 
 
 
 
 

 
 
 
 
 
9. Click “Storage” to select entire columns and then press “Enter” key to display a drop-down menu. 

Then, select “DWORD (Low – High)” and press “Enter” key to complete the setting. (If using a 16-bits 

or below, it’s no need to set the “Storage” item.) 

 
 
 
 
 
 

 
 
 
 
 
 

To expand this “Data Block” and you can see the Modbus addresses of all variables. It equals to the 

“Offset” value plus 1 (Base address).  
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10. Then, we need to add the second “Data Block” for the Modbus Master to read the Boolean data.  

This configure way is similar to the step 4 to 8:  

(1) Click the “Server - …” item and click the “Insert Slave/Data Block” button at the left side to open 

      the settings window.  

(2) In the “MODBUS Slave Request” window, enter a simple note and select the “Input-bits” option, 

      then set “Base address” to “1” and set “Nb items” to “2000”. 

 

 
 
 
 
 
 
 
 
 
 
 

 
 
 
 
 
 
 
 
 
 

(3)  Mouse drags the Boolean variables (i.e., “LED1”, “LED2”; data type: BOOL) one-by-one and drop  
them to the “Symbol” area, and then set the “Offset” to “0” and to “1”. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 

You have completed the settings for the Modbus Slave. Finally, follow the way below to re-compile 

the program and download it to the Win-GRAF PAC. 

 
 
 
 

Enter a simple note 

For the Modbus Master to Read data: 

Option Data Type 

Input Bits BOOL 

Input Registers 
BYTE, INT, DWORD, 
REAL, LINT, etc. 

 (Refer Appendix A to see more data type) 
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11. Click “Project” > “Build All Projects” from the menu bar to compile this program again (refer the 

Section 2.3.4). If a message informs you “No error detected” that means this process is successful. 

 
 
 
 
 
 
 
 
 
 
12. Mouse right-click the project name (i.e., “Demo01”) and select the “Communication Parameters…” 

to set the PAC IP (e.g., “192.168.71.19:502”) and then click the menu bar “Project” > “On Line” (or  

 ) to establish a connection and download this project to the Win-GRAF PAC. (Refer the Section 
2.3.5). 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

(Refer the P1-1 to view all PAC models) 
 

After completing all the steps, the HMI/SCADA software can access to all the Win-GRAF variables listed 

above via Modbus TCP protocol.  

 
 
 
 
 

This version information can be ignored. 

Modbus TCP Slave 

SCADA / HMI Win-GRAF PAC 

IP: 192.168.71.19 
Port: 502 

InduSoft 

Modbus TCP Master 

Slave number = 1 
WP-5xx8 WP-8xx8 
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3.2 To Enable the Win-GRAF PAC as a Modbus RTU Slave 

Before doing this, you must complete all the content that described in Section 3.1 to open the Modbus 

Slave data. The way to enable the Win-GRAF PAC as the Modbus RTU Slave is to add the “MBSLAVERTU” 

or the “MBSLAVERTUEX” function block in the program. To begin, follow these steps: 

 
Add the “MBSLAVERTU” function block 
1. In the “LD1” window, mouse click the place where you want to add this function block and then click 

the  “Insert FB..” button on the left side of the window.  

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
2. Double-click on this function block and select the name “MBSLAVERTU”, then click “OK”. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Tips:   
Press “MBSL” key to quickly 
find out the function name.  

1 

2 

3 
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3. In the “MBSLAVERTU” function block, mouse double-click the left side of the “PORT” and enter a 

string 'COM2:9600,N,8,1' (it means using the Win-GRAF PAC’s COM2 to communication with the 

Modbus Master) and then click    to complete the settings. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
4. Double-click the left side of the “SLV” and then enter “1” (the value set in the Section 3.1 - Step 3), 

then click  to finish the setting. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Now, you have completed the setting of the “MBSLAVERTU” function block, then re-compile the 

program and download it to the Win-GRAF PAC. (Refer the Section 2.3.4, Section 2.3.5) 

 

Note:  Users can enable multiple Modbus RTU Slave ports for each PAC (recommend not over 16 Ports), 

the way is to add multiple “MBSLAVERTU” function blocks and set the different “Port” value. 

 

Tips:   
Press the “F1” key on this 
function block to show up 
the related Help. 
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 (Refer the P1-1 to view all PAC models) 

Add the “MBSLAVERTUEX” function block 

If you have added multiple “Server - …” settings (recommend to set one) in the “IO Drivers” window, the 

“MBSLAVERTUEX” function block must be used. 

 
 
 
 
 
 
 
 
 
 
 
 

1. Follow the step1 to 4 described above to add the “MBSLAVERTUEX” function block. If you want to 

change the usage for existing function block, mouse double-click the “MBSLAVERTU” and change it 

to the“MBSLAVERTUEX”, and then click the “OK” button. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Modbus RTU Slave 

SCADA / HMI 

InduSoft 

Modbus RTU Master 

COM2: RS-232 
9600,N,8,1 

Win-GRAF PAC 

Slave number = 1 
WP-5xx8 WP-8xx8 

Function Block 

Function 
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2. The “MBSLAVERTUEX” has a “SrvID” setting. Double click the left side of the “SrvID” and enter a 

needed “Server ID” (using a string format, e.g., ‘Svr1’). 

Note: 

Using the “MBSLAVERTU” function block means the first Mobus Slave setting will be enabled. 

Using the “MBSLAVERTUEX” function block means to enable the Modbus Slave setting depends on 

the “Server ID”.  

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Now, you have finished the settings for the “MBSLAVERTUEX” function block and then re-compile 

the program and download it to the Win-GRAF PAC. (Refer the Section 2.3.4, Section 2.3.5) 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Tips:   
Press the “F1” on this 
function block to show 
up the related Help. 
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Chapter 4 Linking “I/O Boards” 

This section lists the usage of the “I/O Boards” function in the Win-GRAF Workbench to link the Real I/O 

modules or to enable other I/O functions. First, you need to know the slot numbering and supported I/O 

modules for each PAC: 
 

PAC Model 
Slot No. (from the 
left to the right) 

The supported PAC I/O modules 

WP-8xx8 0 to 7 
Supported: 
 I-8K and I-87K series (High Profile) I/O modules.  
(E.g., I-8017HW and I-87055W) 

 Not Supported: 
I-8K and I-87K series (Low Profile) I/O modules. 
(E.g., I-8017H and I-87055) 

XP-8x48 (*) 

1 to 7 XP-8x48-CE6 (*) 

XP-8x48-Atom-CE6 

VP-25W8 
0 to 2 

VP-4138 

WP-5xx8 - 

Palm-size PAC, it can support one XV board. 
 (E.g., XV107, XV116, XV308, etc.) 
The XV board belongs to the Modbus slave I/O board.  
(Refer the Section 5.1.6 to 5.1.11 for using XV-boards.) 

 

(*) : The XP-8048 and XP-8048-CE6  are the 0-slot PAC.    (Refer P1-1 for all PAC models) 
 
Add the “I/O board” 

“I/O board” refers to the I/O functionality in the Win-GRAF (e.g., “i_8037_DO“) and  

“I/O module” refers to the hardware device (e.g., “I-8037W“).  

 
Notice:   
Besides the software setting for the I/O board, there are some kinds of I/O modules need to set the 

hardware Jumper (e.g., Single-ended and Differential Jumper). So, go to the website to look up the 

product information, or the description printed on the module cover, or the attached shipment 

document.  

I-8K and I-87K series product website: 

http://www.icpdas.com/root/product/solutions/remote_io/rs-485/i-8k_i-87k/i-8k_i-87k_selection.html 
 
 

1. In the Win-GRAF, click the "Open I/Os" button from the toolbar to open the “I/O Boards” window.  

 
 
 
 
 
2. As the figure below, mouse double click the slot number that corresponds to the real I/O module 

and then select the proper I/O board (e.g., i_8037_DO).  

 

Note:  The Slot 0 to Slot 7 are reserved for real I/O modules that plugged into the PAC, and the slot 

8 or above are for other usage.  

 
 

http://www.icpdas.com/root/product/solutions/remote_io/rs-485/i-8k_i-87k/i-8k_i-87k_selection.html
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Buttons Description:  (Click the following buttons to modify the settings) 

 

“Close”: 

 Close this window.  
 

“Select”: 

Open the I/O selecting window. 

( Hot Key - “Enter”: to open ; 

  Hot Key -  “ESC” : to exit) 
 

 “Delete”: 

Delete this I/O board.  
 

 “Rename”: 

Rename this I/O board.   

 

 
 

“Properties”: Look up the usage of this I/O board.  

“Virtual/Real”: Swith the I/O board to a Virtual I/O (for testing) or a Real I/O. (Hot Key – “Space”) 

“Move Up”: Move up this I/O board.  

 “Move Down”:  Move down this I/O board. 

“Help”: To see the description on “I/O devices”.  

 
 
 
 

Select and to see the 
setting description. 
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4.1 DI/DO Boards 

Here use the "I-8055W" as an example, users can refer the Chapter 4 (P4-1) to add this I/O board.  

 

1. Double-click the “i_8055_DI” (or the “i_8055_DO”) to open the “Properties” window.  

Note:  A mouse-over showing the details on the “i_8055_DI” (or the “i_8055_DO”).  

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
2. After linking the “i_8055” I/O board, it will auto add 8 Input and 8 output variables  in the 

“Variables” window that can be used in the program.  

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Setting Description 

%IX1.0 – i_8055_DI 
%QX1.1 – i_8055_DO 

“I” means “Input”         “Q” means “Output” 

“X” means “Boolean”   “1” means “Slot 1” 
 

Note:  
Double-click this item to modify the variable 
name and click “Enter” to accept the setting. 
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4.2 i_scale (Conversion Table) 

The “i_scale” function can set up to 29 scaling functions to convert values for the AI or AO module that 

plugged in the slot 0 to slot 7. See the Chapter4 (P4-1) to add this I/O board.  

 
1. Mouse double click the "i_scale_0" (or "i_scale_1" or "i_scale_2") to open the “Properties” window, 

and then to see the setting description.  

Note: Using the slot 8 or above No. because the slot 0 to slot 7 are reserved for the real I/O module.  

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Parameters:  (“Ch” means the Ch01 to Ch29, "Ch00” is a reserved item) 

Ch_X0_Min_Physical_Val:  The min. value of AI (or AO) boards (X0).  

Ch_X1_Max_Physical_Val:  The max. value of AI (or AO) boards (X1).   

   Ch_Y0_Engineering_Val_For_X0:  The engineering value after scaling X0.  

   Ch_Y1_Engineering_Val_For_X1:  The engineering value after scaling X1.  

 
2. Double click the item and fill in a value, then press the “Enter” key to complete the setting.  

Notice:    

1.  If set both value of Ch_X0 and Ch_X1 to "0.0", it means the relative scaling function No. is 

disabled.  

2.  If Ch_X0 is greater than or equal to Ch_X1, the setting is wrong. 

3. If Ch_Y0 is equal to Ch_Y1, the setting is wrong. 

 
For example, if the AI board's value is 4 to 20 mA and wish to scale as 0 to 10000, then set Ch_X0 as 

"4.0", Ch_X1 as "20.0", Ch_Y0 as "0.0", Ch_Y1 as "10000.0".  

 
 

Setting Description 
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For example, if the AO board's value is -10 to +10 V and their respective engineering value is  

-50 to 1200, then set Ch_X0 as "-10.0", Ch_X1 as "+10.0", Ch_Y0 as "-50.0", Ch_Y1 as 

"+1200.0". 

 
 
 
 
 
 
 
 
 
 
 
 
 
3. After linking the “i_scale” in the “I/O Boards” window, it will auto add 30 Boolean variables in the 

“Variables” window. When the Win-GRAF connects the PAC, it will display the state of each scaling 

function.  

True:   scaling function is ok. 

 FALSE:   scaling function is not enabled or setting error. 
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4.3 i_8017HW (8/16 channels AI) 

The I-8017HW can be an 8-channel differential or a 16-channel single-ended analog input module (Data 

type: "REAL"). The following will describe a 16-channel module, you can see the Chapter4 (P4-1) to add 

this I/O board. 

Note:  Before using the I-8017HW I/O module, it requires to set the Differential or Single-ended 

Jumper in the hardware.  

1. Mouse double click the "i_8017_16ch" to open the “Properties” window, and then to see the 
setting description. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Parameters: 

Ch_type:  16#SSRR  

    SS : Scaling function is defined by the "i_scale" I/O board (see the Section 4.2). 

00   means "No scaling".  

01 to 29 means "Appling a scaling function No. (01 to 29)". 

Setting “SS” as other value will use the default value 00. 

    RR : Range definition of signals. 

05 means "physical input signal is -2.5 to +2.5 Volt".  

06 means "physical input signal is -20 to +20 mA".  

07 means "physical input signal is -1.25 to +1.25 Volt".  

08 means "physical input signal is -10 to +10 Volt".  

09 means "physical input signal is -5 to +5 Volt".  

Setting “RR” as other value will use the default value 08. 

 
 

Setting Description 
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2. Double click the item and fill in a value, then press the “Enter” key to complete the setting. 
 

For example, 16#08 means the physical input signal is -10 to +10 V.  

Channel value 5.67 means the input signal is 5.67 V. 

For example, 16#209 means the physical input signal is -5 to +5 V with the scaling function 2. 

Signal 5.67 V will be scaled to an engineering value by the scaling function 2. 

For example, 16#1709 means the physical input signal is -5 to +5 V with the scaling function 17. 

Signal 5.67 V will be scaled to an engineering value by the scaling function 17. 

 
 
 
 
 
 
 
 

Noise_Filter_Max:  The max. of the physical value to be considered as noise.  

The filter will filter out the signal value beyond it, default setting is "9999.9". 

For example, set as “7.9”, signal larger than 7.9 V (or 7.9 mA) will be filtered out. 
 

Noise_Filter_Min:  The min. of the physical value to be considered as noise.  

The filter will filter out the signal value beyond it, default setting is "-9999.9". 

For example, set as “1.5”, signal smaller than 1.5 V (or 1.5 mA) will be filtered out. 

Note:  

      If setting Noise_Filter_Min >= Noise_Filter_Max, filter is disabled. 

      If setting  Noise_Filter_Min < -1000 and Noise_Filter_Max > 1000, the filter is disabled.  
 

Sample_Number:  The number of sampled data to be averaged as one data.  

Default is “1” (range: 1 to 500). Set a bigger value will reduce the sampling rate, 

however the signal curve is smoother than setting a small value. 
  

3. After linking the “i_8017_16ch” in the “I/O Boards” window, it will auto add 16 "REAL” input 

variables in the “Variables” window. These variables can be used in the program.  

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

You can change the variable 
name by double clicking it. 
(See the Section 4.1) 
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4.4 i_8024 (4-channel AO) 

The I-8024W is a 4-channel analog output module (Data type: "REAL") that can be used to output +/- 10 

V or 0 to +20 mA signal. See the Chapter4 (P4-1) to add this I/O board. 

 
1. Mouse double-click the "i_8024_AO" to open the “Properties” window and then to see the setting 

description. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Parameters:  

Ch_type:  16#SSRR  

    SS: Scaling function is defined by the "i_scale" I/O board (see the Section 4.2). 

00   means "No scaling".  

01 to 29 means "Appling a scaling function No. (01 to 29)". 

Setting “SS” as other value will use the default value 00. 

    RR: Range definition of signals 

30 means "physical output signal is 0 to 20 mA"  

33 means "physical output signal is -10 to +10 Volt" 

         Setting “RR” as other value will use the default value 33. 

 

2. Double click the item and fill in a value, then press the “Enter” key to complete the setting. 
 

For example, 16#33 means the physical output signal is -10 to +10 V.  

Channel value 5.67 is to output 5.67 V ;  value -3.752 is to output -3.752 V. 
 

For example, 16#133 means the physical output signal is -10 to +10 V with the scaling function 1. 

Channel value is a user-defined engineering value will be converted first by the scaling 

function 1 (i.e., "Ch01") before output it as -10 to +10 V. 

 

Setting Description 
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For example, 16#30 means the physical output signal is 0 to 20 mA. 

Channel value 12.5 is to output 12.5 mA ;  value 6.27 is to output 6.27 mA. 
 

For example, 16#1730 means the physical output signal is 0 to 20 mA with the scaling function 17. 

Channel value is a user-defined engineering value will be converted first by the scaling 

function 17 (i.e., "Ch17") before output it as 0 to 20 mA. 

 

 

 
 
 
 
 
 
 
 
3. After linking the “i_8024_AO” in the “I/O Boards” window, it will auto add 4 "REAL” Output variables  

in the “Variables” window. These variables can be used in the program. 

 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

You can change the variable 
name by double clicking it. 
(See the Section 4.1) 
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4.5 i_87018W (8-channel AI) 

The I-87018W is an 8-channel analog input module (Data type: "REAL") that provides thermocouple 

input, current input (-20 mA to +20 mA) and voltage input (+/- 15 mV, +/- 50 mV, +/- 100 mV, +/- 500 

mV, +/- 1 V, +/- 2.5 V). See the Chapter4 (P4-1) to add this I/O board. 

 
Important Notice:  
 I-87018ZW is better than I-87018W / I-87018RW / I-87018PW because  

(A)  Each channel can use different range type setting.  

(B)  Accuracy is better and total 10-Channels.  

(C)  Temperature input with sensor-broken-line detection.  

Please visit http://www.icpdas.com/products/Remote_IO/i-87k/i-87018z.htm 

 I-87018W does not support sensor-broken line function.  

 
1. Mouse double-click the "i_8018_08ch" to open the “Properties” window, and then to see the setting 

description. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
Parameters: 

Tmp_F: 16#FF  

FF: Temperature format, It only apply to the channel type is Thermocouple. 

         01 means the unit of the input value is Degree Celsius 

         02 means the unit of the input value is Degree Fahrenheit  
 

Ch0_7_type: 16#RR  

RR: Range definition of signals.  

 
 

Setting Description 

http://www.icpdas.com/products/Remote_IO/i-87k/i-87018z.htm
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Normal Range:  (For mA or Volt) Thermocouple Range: (For temperature) 
 

Type Code Physical Input Signal 

00 -0.015 to +0.015 V 

01 -0.05 to +0.05 V 

02 -0.1 to +0.1 V 

03 -0.5 to +0.5 V 

04 -1 to +1 V 

05 -2.5 to +2.5 V 

06 20 to +20 mA 

When I-87018 and I-87018R are connected 
to a current source and set to “06” type 
code, an optional external 125 Ohm resistor 
is required.  
 
 

 

Type Code Type Physical Input Signal  

0E J -210 to +760 °C 

0F K -270 to +1372 °C 

10 T -270 to +400 °C 

11 E -270 to +1000 °C 

12 R 0 to +1768 °C 

13 S 0 to +1768 °C 

14 B 0 to +1820 °C 

15 N 0 to +2320 °C 

17 L -200 to +800 °C 

18 M -200 to +100 °C 

19 LDIN43710 -200 to +900 °C 

Setting RR as other value will use the default value “05” 

2. Double click the item and fill in a value, then press the “Enter” key to complete the setting.  

For example, 16#05 means the physical input signal is -2.5 to +2.5 V.  

Channel value 1.28 means the input signal is 1.28 V.  

Channel value -0.752 means the input signal is -0.752 V.  

For example,  If "Ch0_7_type" set as 16#0F and "Tmp_F" set as 16#01 means the physical input 

signal is -270 to +1372 degree Celsius. 

Channel value 25.75 means 25.75 degree Celsius.  

For example,  If "Ch0_7_type" set as 16#10 and "Tmp_F" set as 16#01 means the physical input 

signal is -454 to +752 degree Fahrenheit. 

Channel value 25.75 means 25.75 degree Fahrenheit.  

 
 
 
 
 
 
 
 
 
 
Note:  If using a temperature module with a broken-line detection function (e.g., I-87018ZW), and the 

temperature value is greater than "9000.0", it means,  

1. The temperature sensor may be broken-line.  

2. The temperature sensor may be damaged.   

3. The DCON module is not configured well to fit the connected temperature sensors. 

4. The ohm measured by the connected sensor is not correct. 
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           Ch0_scale to Ch7_scale: 16#SS  

SS: Scaling function is defined by the "i_scale" I/O board (refer the Section 4.2). 

00   means "No scaling".  

01 to 29 means "Appling a scaling function No. (01 to 29)" 

Setting SS as other value will use the default value 00. 

  

For example, 16#17 means the physical input signal is converted with the scaling function 17.  

  

3. After linking the “i_87018_08ch” in the “I/O Boards” window, it will auto add 8 "REAL” input 

variables in the “Variables” window that are available for programing. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

You can change the variable 
name by double clicking it. 
(See the Section 4.1) 
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4.6 i_exist (Test if the I/O module exists?) 

The “i_exist” is used to check if the I-8K and I-87K series I/O modules exist in the PAC‘s slot 0 to 7.  

See the Chapter4 (P4-1) to add this I/O board. 

 

1. Mouse double-click the "i_exist" to open the “Properties” window, and then to see the setting 

description. 

Note: Using the Slot 8 or above No. because the slot 0 to slot 7 are reserved for the real I/O module. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
2. After linking the “i_exist” in the “I/O Boards” window, it will auto add 8 "BOOL” input variables in 

the “Variables” window and display the state of the I/O module from slot 0 to slot 7 when 

connecting the Win-GRAF PAC.  

"TRUE" means the I/O module exists.  

"FALSE" means can not find this I/O module.  

 
 
 
 
 
 
 
 
 
 
 
 

You can change the variable 
name by double clicking it. 
(See the Section 4.1) 

Setting Description 
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4.7 i_8084 (Frequency, UP/Down Counter, UP Counter) 

The I-8084W is a 4/8-channel high speed Frequency/Counter (Data type: “DINT”) that can be used to 

measure frequency or as a UP/Down Counter or as a UP Counter. The following will describe these three 

modes. See the Chapter4 (P4-1) to add this I/O board. 

 

4.7.1 i_8084_freq (8-channel Frequency) 

1. Mouse double-click the "i_8084_freq" to open the “Properties” window, and then to see the setting 

description. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Parameters:  
Ch_Filter:  The unit is 0.000001 second (μs), the value can be 0 to 200.  

The default setting is 0 (without filter). The "Ch_Filter" is for filtering out some noise 

signals with smaller signal width. (Recommend 0: if there is no noise consideration or 

need a real-time measurement.) The following setting is recommended: 
 

Max Input Signal (Hz) Recommend Filter Value 

1K 200 

2K 100 

5K 40 

10K 20 

20K 10 

100K 2 

450K 1 

450K 0 (without filter) 

 

Setting Description 
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Ch_Freq_Timeout:  
The unit is 0.001 second (ms), the value can be 20 to 1800. Set as other value will use the 

default value 1800. If there is no signal wave input to the I-8084W in the "Ch_Freq_Timeout" 

interval, the frequency value of the related channel will be assigned as 0. 

 

For example, if set it as 100 ms and the input is 500 Hz (that means, one signal wave takes 

about 2 ms to happen), the frequency is updated normally. When the input frequency drop to 9 

Hz (that means, one signal wave take about 111 ms to happen), this "111" exceeds the setting 

"100" ms (Freq_Timeout). So the frequency value will be assigned as 0 because there is no 

signal wave coming in this 100 ms interval. 

 

When setting as 20 ms, the frequency value below 50 Hz is not detectable (become 0).  

When setting as 100 ms, the frequency value below 10 Hz is not detectable (become 0).  

When setting as 1800 ms, the frequency value of 0 Hz , 1 Hz to 450 KHz is detectable. 

 
   

Ch_Low_High_Auto:  (recommend setting as “2: Auto”.) 
0  means a Low frequency mode. 

1 means a High frequency mode. 

2  means Auto switching between Low and High frequency mode. 

Set as other value will use the default value “2: Auto”. 
 

Mode 2 will auto change the frequency mode. It will auto change to High mode when the input 

frequency is larger than 3500 Hz, while auto change to Low mode if input frequency is less than 

1000 Hz. 
 

DO NOT set as 1 (High frequency mode) if the input signal is normally less than 1000 Hz, or the 

frequency value will be incorrect frequently. Recommended don't set as 0 (Low frequency 

mode) if the input signal is normally larger than 3500 Hz. 

         
Min_Update_Interval:  

The unit is 0.001 second (ms), the value can be 0, or 20 to 1000. 

Default value 0 means "Update frequency every PAC cycle".  

Other means "Update frequency when each Interval time reached".  

The frequency update time also depends on the Win-GRAF PAC cycle time. If the PAC cycle time 

is big, for example 200 ms, then the real frequency update time will become 200 ms when 

setting the "Min_Update_Interval" less than 200. Setting bigger "Min_Update_Interval" will get 

smooth frequency curve value, however the frequency value is updated slowly. 

   
Signal_Inverted:  

0 :  input signal is normal (no inverted). 

1 : input signal is inverted (means voltage HIGH will be processed as LOW, and voltage LOW 

will be processed as HIGH). 
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2. Double click the item and fill in a value, then press the “Enter” key to complete the setting. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
3. After linking the “i_8084_freq” in the “I/O Boards” window, it will auto add 8 “DINT” input variables 

in the “Variables” window. When the Win-GRAF connects the PAC, it will display the frequency value 

for each channel.  

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

You can change the variable 
name by double clicking it. 
(See the Section 4.1) 
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4.7.2 i_8084_cnt_ch04 (4-channel UP/Down Counter) 

Note:   Using the "COUNTER_START", "COUNTER_STOP", "COUNTER _GET", "COUNTER_STATE" and  

"COUNTER_RESET" functions in the Win-GRAF Workbench to operate counter channels in an 

I-8084W. 
 

1. Mouse double-click the "i_8084_cnt_ch04" to open the “Properties” window, and then to see the 

setting description. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 

Parameters: 

Ch_Mode: Input mode, can be 0 , 1 and 4. Set other value will use 0. 

0:  Pulse/DIR  mode. 

1:  UP/DOWN  mode. 

4:  A/B phase (Quard.) mode. 

Ch_Filter: The unit is 0.000001 second (μs), the value can be 0 to 200.  

The default setting is 0 (without filter). The "Ch_Filter" is for filtering out some noise 

signals with smaller signal width. (Recommend 0: if there is no noise consideration or 

need a real-time measurement.) The following setting is recommended: 
 

Max Input Signal (Hz) Recommend Filter Value 

1K 200 

2K 100 

5K 40 

10K 20 

20K 10 

100K 2 

450K 1 

450K 0 (without filter) 

Setting Description 
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Signal_Inverted:  
0: Input signal is normal (no inverted). 

1: Input signal is inverted (means voltage HIGH will be processed as LOW, and voltage LOW 

will be processed as HIGH). 

For example: 

If setting "Signal_Inverted" as 0 (no inverted) and Ch_Mode is 0 (Pulse/DIR), 

the counter value will count up if "DIR" signal is High.  

If setting "Signal_Inverted" as 1 (inverted) and Ch_Mode is 0 (Pulse/DIR),  

the counter value will count down if "DIR" signal is High.  

 
2. Double click the item and fill in a value, then press the “Enter” key to complete the setting. 
 
 
 
 
 
 
 
 
 
 
 
 
 
3. After linking the “i_8084_cnt_ch04” in the “I/O Boards” window, it will auto add one “BOOL” Input 

variable (no meaning, always  “FALSE”) in the “Variables” window.  

 
 
 
 
 
 
 
4. After linking the “I/O board”, refer the Section 4.9 to use "COUNTER_START", "COUNTER_STOP", 

"COUNTER _GET", "COUNTER_STATE" and “COUNTER_RESET” functions in the LD or ST  program to 

operate the Counter channel of the I-8084W. 
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4.7.3 i_8084_cnt_ch08 (8-channel UP Counter) 

Note:   Using the "COUNTER_START", "COUNTER_STOP", "COUNTER _GET", "COUNTER_STATE" and  

"COUNTER_RESET" functions in the Win-GRAF Workbench to operate counter channels in an 

I-8084W. 
 

1. Mouse double-click the "i_8084_cnt_ch08" to open the “Properties” window, and then to see the 

setting description.  

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

 
 

Parameters: 
Ch_Filter: The unit is 0.000001 second (μs), the value can be 0 to 200.  

The default setting is 0 (without filter). The "Ch_Filter" is for filtering out some noise 

signals with smaller signal width. (Recommend 0: if there is no noise consideration or 

need a real-time measurement.) The following setting is recommended: 
 

Max Input Signal (Hz) Recommend Filter Value 

1K 200 

2K 100 

5K 40 

10K 20 

20K 10 

100K 2 

450K 1 

450K 0 (without filter) 

Signal_Inverted:  
0:  Input signal is normal (no inverted) 
1:  Input signal is inverted (means voltage HIGH will be processed as LOW, and voltage LOW will 

be processed as HIGH). 

Setting Description 
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2. Double click the item and fill in a value, then press the “Enter” key to complete the setting. 

 
 
 
 
 
 
 
 
 
 
 
 
 
3. After linking the “i_8084_cnt_ch08” in the “I/O Boards” window, it will auto add one “BOOL” Input 

variable (no meaning, always  “FALSE”) in the “Variables” window. 

 
 
 
 
 
 
 
 
4. After linking the “I/O board”, refer the Section 4.9 to use "COUNTER_START", "COUNTER_STOP", 

"COUNTER _GET", "COUNTER_STATE" and “COUNTER_RESET” functions in the LD or ST  program to 

operate the Counter channel of the I-8084W. 
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4.8 i_8093 (3-axis High Speed Encoder Module) 

The I-8093W is a 3-axis high speed encoder module that can be independently configured as one of the 

Quadrant, Pulse/Direction or CW/CCW input mode for each channel. If not familiar with the way to add 

the this I/O board, see the Chapter4 (P4-1).  

 

1. Mouse double-click the "i_8093" to open the “Properties” window, and then to see the setting 

description.  

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
 

Parameters: 

X_Mode, Y_Mode, Z_Mode:   

The input mode of X, Y, Z axis, can be 1, 2 and 3. Set other value will use 1. 

1:   CW/CCW counting mode. 

2:   Pulse/Directioncounting mode. 

3:   A/B phase (quadrant) counting mode. 

 
Signal_Inverted:  

0:  Input signal is normal (no inverted) 

1:  Input signal is inverted (means voltage HIGH will be processed as LOW, and voltage LOW will 

be processed as HIGH). 

For example: 

If setting "Signal_Inverted" as 0 (no inverted) and X_Mode is 2 (Pulse/Direction), 

the encoder value will increase if "Dirextion" signal is High.  

If setting "Signal_Inverted" as 1 (inverted) and X_Mode is 2 (Pulse/Direction), 

the encoder value will decrease if "Dirextion" signal is High.  

 

 

Setting Description 
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2. Double click the item and fill in a value, then press the “Enter” key to complete the setting. 
 
 
 
 
 

 
 
 
 
 
 
 
 
3. After linking the “i_8093” in the “I/O Boards” window, it will auto add 3 “BOOL” input variables in 

the “Variables” window that are available for programing.  

Ch0:  Z-index of X axis. 

Ch1:  Z-index of Y axis. 

Ch2:  Z-index of Z axis. 

 

 
 
 
 
 
 
 
4. After linking the “I/O Boards”, refer the Section 4.9 to use "COUNTER_START", "COUNTER_STOP", 

"COUNTER _GET", "COUNTER_STATE" and “COUNTER_RESET” functions in the LD or ST  program to 

operate the Encoder channel of the I-8093W. 
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4.9 Using the Count Function for I-8084W, I-8093W, I-87082W, I-87084W, 
I-7083 and I-7080 Modules 

This section lists the way to use the "COUNTER_START", "COUNTER_STOP", "COUNTER _GET", 

"COUNTER_STATE" and “COUNTER_RESET” functions in the LD or ST program to operate the Counter 

and Encoder modules. If not familiar with the way to create a  program or a function block, see the 

Section 2.3.3. 

 

Note: 

1. In the following content, we use I-8084W and I-8093W modules as examples. 

2. Before using these function blocks, first go to Section 4.7.2 (UP/Down Counter), Section 4.7.3  

(UP Counter) and Section 4.8 (Encoder) to link I/O Boards. 

 
 

4.9.1 COUNTER_START  

For example:  Using the I-8084W module in the PAC‘s slot2 and start counting the channel 5. 

 

ST program:   

 
 
 
 
 

 
 
 
 

LD program: 

(“Start1”: boolean, set it to “TRUE” to start counting and then reset “Start1” to “FALSE”.) 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

IF   Start1 = TRUE   THEN 

   Start1  :=  FALSE ; 

   TMP_BOOL  :=  Counter_Start (0, 2, 8084, 5) ; 

END_IF ;  

Note:  
First, add two BOOL variables 
("Start1", "TMP_BOOL") in the 
Variables Area. 

Reset it to “FALSE” 

Set it to “TRUE” to start counting 

Click to set 
“Coil” to “R”. 

Tips:   
Press the [F1] key for 
the details on settings. 
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Port:  (Data type: “DINT”)  

For a module in the slot 0 to 7 of the PAC, set it as “0”. For a DCON module connected to a serial 

COM port, can be “1 to 37” (depends on PAC, means COM1 to COM37). 

 
Addr: (Data type: “DINT”) 

For a module in the slot 0 to 7 of the PAC, set it as the slot number (0 to 7). 

For a module connected to a serial COM port, set it as the Net-ID address of the module (1 to 255). 

 

IO_Name: (Data type: “DINT”) 

The name of relative Counter/Encoder module, it can be set to "8084”, "8093", "87084", "87082", 

"7083" and "7080". 

 

Channel: (Data type: “DINT”)  

The channel No. of the Counter/Encoder module, it can be set to "0", "1", and so on, depends on the 

module. For example, when using the I-8093W module, "0" means the X-axis, "1" means the Y-axis  

and  "2" means the Z-axis. 

 

Q:  (Data type: “BOOL”) 

“TRUE”: OK   ;   “FALSE”: Error. 
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4.9.2 COUNTER_STOP 

For example:  Using the I-8093W module in the PAC‘s slot1 and stop counting the X-axis. 

 
ST program:   

 
 
 
 
 
 
 

 

LD program: 

(“Stop1”: Boolean, set it to “TRUE” to start counting and then reset “Stop1” to “FALSE”.) 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Port:  (Data type: “DINT”)  

For a module in the slot 0 to 7 of the PAC, set it as “0”. For a DCON module connected to a serial 

COM port, can be “1 to 37” (depends on PAC, means COM1 to COM37). 
 

Addr: (Data type: “DINT”) 
For a module in the slot 0 to 7 of the PAC, set it as the slot number (0 to 7). 
For a module connected to a serial COM port, set it as the Net-ID address of the module (1 to 255). 
 

IO_Name: (Data type: “DINT”) 
The name of relative Counter/Encoder module, it can be set to "8084”, "8093", "87084", "87082", 
"7083" and "7080". 
 

Channel: (Data type: “DINT”)  

The channel No. of the Counter/Encoder module, it can be set to "0", "1", and so on, depends on the 

module. For example, when using the I-8093W module, "0" means the X-axis, "1" means the Y-axis  

and  "2" means the Z-axis. 
 

Q:  (Data type: “BOOL”) 

“TRUE”: OK   ;   “FALSE”: Error. 

 

Set it to “TRUE” to stop counting 
 

IF   Stop1 = TRUE   THEN 

   Stop1  :=  FALSE ; 

   TMP_BOOL  :=  Counter_Stop (0, 1, 8093, 0) ; 

END_IF ;  

 

Note:  
First, add two BOOL variables 
("Stop1", "TMP_BOOL") in the 
Variables Area. 

Tips:   
Press the [F1] key for 
the details on settings. 

Reset it to “FALSE” 
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4.9.3 COUNTER_GET  

For example:  Using the I-8093W module in the PAC‘s slot1 and get the Encoder value of the Z-axis. 

 
ST program:   

 
 
 

 
LD program: 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Port:  (Data type: “DINT”)  

For a module in the slot 0 to 7 of the PAC, set it as “0”. For a DCON module connected to a serial 

COM port, can be “1 to 37” (depends on PAC, means COM1 to COM37). 
 

Addr: (Data type: “DINT”) 
For a module in the slot 0 to 7 of the PAC, set it as the slot number (0 to 7). 
For a module connected to a serial COM port, set it as the Net-ID address of the module (1 to 255). 
 

IO_Name: (Data type: “DINT”) 
The name of relative Counter/Encoder module, it can be set to "8084”, "8093", "87084", "87082", 
"7083" and "7080". 
 

Channel: (Data type: “DINT”)  

The channel No. of the Counter/Encoder module, it can be set to "0", "1", and so on, depends on the 

module. For example, when using the I-8093W module, "0" means the X-axis, "1" means the Y-axis  

and  "2" means the Z-axis. 
 

@Value: (The data type can be “DINT”, “UDINT”, “DWORD”, “LINT” and “ULINT”)  

It returns the current counter or encoder value. (Refer the Appendix A for the range of values) 
 

Q:  (Data type: “BOOL”) 

Counting state.  “TRUE”: Counting   ;   “FALSE”: Stopped. 

 
 

TMP_BOOL  :=  Counter_Get (0, 1, 8093, 2, Encoder_1) ; 

Note:   First, add variables in the 
Variables Area (see section 2.2.1). 
"TMP_BOOL"  (BOOL). 
“Encoder_1"  (DINT).  

Tips:   
Press the [F1] key for 
the details on settings. 
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4.9.4 COUNTER_STATE 

For example:  Using the I-8084W module in the PAC‘s slot2 and to get the counting status of the 

channel 5. 

 
ST program:   

 
 
 
 

 
LD program: 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Port:  (Data type: “DINT”)  

For a module in the slot 0 to 7 of the PAC, set it as “0”. For a DCON module connected to a serial 

COM port, can be “1 to 37” (depends on PAC, means COM1 to COM37). 
 

Addr: (Data type: “DINT”) 
For a module in the slot 0 to 7 of the PAC, set it as the slot number (0 to 7). 
For a module connected to a serial COM port, set it as the Net-ID address of the module (1 to 255). 
 

IO_Name: (Data type: “DINT”) 
The name of relative Counter/Encoder module, it can be set to "8084”, "8093", "87084", "87082", 
"7083" and "7080". 
 

Channel: (Data type: “DINT”)  

The channel No. of the Counter/Encoder module, it can be set to "0", "1", and so on, depends on the 

module. For example, when using the I-8093W module, "0" means the X-axis, "1" means the Y-axis  

and  "2" means the Z-axis. 
 

Q:  (Data type: “BOOL”) 

“TRUE”: OK   ;   “FALSE”: Error. 

 
 
 

TMP_BOOL  :=  Counter_State (0, 2, 8084, 5) ; 
Note: First,  add a  "TMP_BOOL" 
BOOL variable in the Variable Area. 

Tips:   
Press the [F1] key for 
the details on settings. 
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4.9.5 COUNTER_RESET 

For example:  Using the I-8093W module in the PAC‘s slot5 and reset the Encoder value of the Y-axis 

as "0". 
 

ST program:   
 
 
 

 
 
 

LD program: 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Port:  (Data type: “DINT”)  

For a module in the slot 0 to 7 of the PAC, set it as “0”. For a DCON module connected to a serial 

COM port, can be “1 to 37” (depends on PAC, means COM1 to COM37). 
 

Addr: (Data type: “DINT”) 
For a module in the slot 0 to 7 of the PAC, set it as the slot number (0 to 7). 
For a module connected to a serial COM port, set it as the Net-ID address of the module (1 to 255). 
 

IO_Name: (Data type: “DINT”) 
The name of relative Counter/Encoder module, it can be set to "8084”, "8093", "87084", "87082", 
"7083" and "7080". 
 

Channel: (Data type: “DINT”)  

The channel No. of the Counter/Encoder module, it can be set to "0", "1", and so on, depends on the 

module. For example, when using the I-8093W module, "0" means the X-axis, "1" means the Y-axis  

and  "2" means the Z-axis. 
 

Value: (The data type can be “DINT”, “UDINT”, “DWORD”, “LINT” and “ULINT”)  
The new Counter or Encoder value wish to set. 

 

Q:  (Data type: “BOOL”) “TRUE”: OK   ;   “FALSE”: Error. 

“Reset1”: BOOL, set it to 
“TRUE” to reset the value. 

IF   Reset1 = TRUE   THEN 

   Reset1  :=  FALSE ; 

   TMP_BOOL  :=  Counter_Reset (0, 5, 8093, 1, 0) ; 

END_IF ;  

Note:  
First,  add two BOOL variables 
("Reset1", "TMP_BOOL") in the 
Variable Area. 

Tips:   
Press the [F1] key for 
the details on settings. 

Reset it to “FALSE” 
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4.10 Ping_ip (Test an Ethernet/Internet Connection) 

The "Ping_ip" function is used to test if the connection of the remote Ethernet/ Internet device is 

working properly. (It supports a max. of 50 IP settings.) If not familiar with the way to add this I/O board, 

see the  Chapter4 (P4-1).  

 
1. Mouse double-click the "Ping_ip" to open the “Properties” window, and then to see the setting 

description.  
Note: Using the slot 8 or above No. because the slot 0 to 7 are reserved for the real I/O module. 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Note: 

1. If wish to test the connection between PAC and Internet, please set proper "Gateway" settings. 

2. If test only local Ethernet connection, then "Gateway" may not be necessary. 

3. One PAC can use only one "Ping_IP". (Don't use two or more) 

4. When Ping success, return Boolean channel as TRUE. 

5. When Ping fails, it will try one more time. If still fail, then return Boolean channel as FALSE. 

 
Parameters: 

IP_01 to IP_49:  (Data type: "STRING") 

The IP address of targets.  Set as 'N/A' if wish to disable it. 

For example,  192.168.1.100  or  52.19.125.242  or  N/A. 

 

Interval_01 to Interval_49:  (Data type: "DINT") 

The unit is second. The interval to send one "ping" command.  Value can be 6 to 86,400 seconds.  

Setting smaller than 6 will use as 6. Setting greater than 86400 (24 hours) will use as 86400.  

 

Setting Description 
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Timeout_01 to Timeout_49:  (Data type: "DINT") 

The unit is second. The timeout settings of the "ping" command. Value can be 2 to 30 seconds.  

Setting smaller than 2 will use as 2. Setting greater than 30 will use as 30. 
       

Note:  The "Interval_xx" value should be at least triple of the "Timeout_x" value. Or the PAC will 

use the "Interval_x" value as a triple of the "Timeout_x" value. 

 For example, if "Timeout_00" is set as 10 however "Interval_00" is set as 20, then PAC will 

use "Interval_00" as 30. 

       
2. Double click the item and fill in a value, then press the “Enter” key to complete the setting. 

 
 
 
 
 
 
 
 
 
 
 
 
 
3. After linking the "Ping_ip" in the “I/O Boards” window, it will auto add 50 “BOOL” input variables in 

the “Variables” window. When the Win-GRAF connects the PAC, it will display the online status.  

True:   The connection is ok.   

FALSE:  Connection failed or cable problem. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

You can change the variable 
name by double clicking it. 
(See the Section 4.1) 
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4.11 I-8088W (8-channel PWM Output Module) 

The I-8088W is an 8-channel PWM (Pulse Width Modulation) output module. The duty range (Duty = 

High / (High + Low) ) of the PWM output signal can be from 0.1% to 99.9%. Its output frequency in the 

Win-GRAF PAC is from 1 Hz to 500 KHz. The I-8088W support two PWM output modes, one is the 

“Continuous” mode. It outputs always. The other one is the “Burst” mode. It outputs the required pulse 

count and then stop. Please visit http://www.icpdas.com/products/Remote_IO/i-8ke/i-8088w.htm for 

other specifications.  

 
Hardware Connection Diagram: 

This example uses the I-8084W (Slot 2) to measure the frequency of the I-8088W (Slot 1) PWM output 

signal (the I-8084W is not necessary in the actual application). Then, connect the I-8088W’s PWM 

output channel 0 (PW0) to the I-8084W’s frequency input channel 0 (C0A+).  

 
 
 
 
 
 
 
 
 
 
 
 
The demo program (demo_8088w.zip) that we will describe below is located in the shipment CD  

(\Napdos\Win-GRAF\demo-project) , refer the Chapter 12 to restore/open this project  and set up the 

current PAC‘s IP address.  

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Right-click (set the IP) 

http://www.icpdas.com/products/Remote_IO/i-8ke/i-8088w.htm
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I/O Boards: 
In this case, add the "i_8088" and the "i_8084_freq" to the corresponding I/O slot No. in the "I/O 

Boards" window (see the Chapter 4).  Then, mouse double-click the Slot No. to open the "Properties" 

window and you can see the setting description to set this I/O board.  

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

After linking the "i_8088" and the "i_8084_freq" I/O boards, it will auto add related variables in the  

"Variables" window (or Variables Area). And, you can also declare all the variables that will be used in 

the program here (refer the Section 2.3.1).  

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Double-click it to change its name. 
(Refer the Section 4.1) 

To declare all the variables that 
will be used in the program. 

Double-click it to set 
and to see the details. 

Setting Description 

Double-click it to set up this item. 
“00“ means the associate PWM output channel 
is triggered by the "i_8088W" function block. 
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"PWM_8088W" Function Block: 

Then, using the function block “PWM_8088W” to control the PWM output for each channel, such as the 

LD program below.  

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Parameters: 
Slot:     The used I/O slot No., and it must be a constant value, not a changeable value.  

 In this case, the value is "1". (Data type: DINT) 

Chan: The used I/O channel No., and it must be a constant value, not a changeable value.  

In this case, the value is "0". (Data type: DINT)  

Freq: The PWM output frequency. (Data type: DINT ; Unit: Hz)  

The value can be from 1 to 500,000 (i.e., 1 Hz to 500 KHz) .  

In this case, the initial value is "100" Hz.  

Duty: The PWM output. (Data type: REAL) 

The value can be from 0.001 to 0.999 (i.e., 0.1 % to 99.9 %).  

In this case, the initial value is 0.5 (i.e., 50 %).  

Cnt: The output mode (Data type: DINT) 

Continuous mode: set it as “-1” (in this case) to output PWM pulse continuously.  

Burst mode: it can be from "1" to "65535", to output the required pulse count and then stop.  

Run: Using a BOOL variable to trigger the PWM output. (True: Start ; False: Stop) 

State: The current working status. (Data type: BOOL). (True: working ; False: stopped) 

 
 
 
 

Slot and Chan must 
use constant value. 

Freq: PWM frequency 
(Data type: DINT) 
Duty: PWM duty 
(Data type: REAL) 

Cnt:  DINT，"-1"                (Continuous mode), used to output PWM pulse continuously. 

             "1 ~ 65535" (Burst mode), used to output the required pulse count and then stop. 
Run:  BOOL, used to start (True) or stop (False) the PWM output. 

BOOL, always returns “Ture” 

State:  BOOL, the current working status. 

(True: working ; False: stopped) 

Num: DINT, it reserved for future usage. 



Win-GRAF User Manual,  V 1.00,  Jul. 2014  by ICP DAS     4-34 

 

Test the program: 

Before testing, make sure you have set the PAC's IP address and then compile and download this 

program to the PAC. (If not familiar with the operation, refer the Section 2.3.4 and Section 2.3.5.) 

 
When connecting with the PAC, the SPY List (refer the Section 11.3) will show that the I-8088W’s PWM 

initial frequency ("i8088_Freq0") is 100 Hz, the initial duty cycle ("i8088_Duty0") is 50%, using the 

Continuous mode ("i8088_Cnt0" = -1) and the currently measured frequency of the I-8084W is 0 Hz.  

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Now, set the "i8088_Run0" as "TRUE" to start the PWM output. At this time, the "i8088_State" will 

change from "FALSE" to "TRUE" and output a PWM signal to the I-8084W module, and then the value of 

the "i8084_Freq0" will change from 0 Hz to 100 Hz.  

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
If set the "i8088_Cnt0" as 500 (Burst mode), the "i8084_Freq0" value will become 0 after the I-8088W 

outputs 500 PWM pulses. You can try to change the "i8088_Cnt0" value and then set the "i8088_Run0" 

as "TRUE" to view the changes of output.  
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Chapter 5 Modbus Master: connect to Modbus Slave Device 

This chapter lists the way to enable the Win-GRAF PAC as a Modbus Master to connect a Modbus 

RTU/ASCII Slave or Modbus TCP/UDP Slave device. If you want to use one XV board in the WP-5000, 

refer the Section 5.1.6 to Section 5.1.11. 

 

5.1 Enabling the Win-GRAF PAC as a Modbus RTU/ASCII Master 

Application Diagram: 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

(Refer the P1-1 to view all PAC models) 
 

Follow these steps: 

1. Mouse click the “Open Fieldbus Configuration” tool button to open “IO Drivers” window.  
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2. Click the “Insert Configuration” button on the left of the “IO Drivers” window, then click the 

“MOSBUS Master” and “OK” to enable the Modbus Master setting.  

 
 
 
 
 
 
 
 
 
 
 
 
3. Click the “Insert Master/Port” button on the left side to open the setting window. Then, select the 

“Serial MODBUS-RTU”,  set COM Port (e.g., “COM2:9600,N,8,1”) and Delay time (recommended 

value: 10 ms, it can be 0 to 10000), and then click  “OK”.  

 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
 
 
 
 
 
 
 
 
4. Click the “Insert Slave/Data Block” button on the left side to create a data block.  
 
 
 
 
 
 
 
 
 
 

Select “Disabled” if you do not want 
to use this COM Port setting. 

After receiving the respond, waiting for 
10 ms to send the next command  

If set it as a Modbus ASCII 
Master, change the setting to  
“ASCII:COM2:9600,N,8,1” 
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This table lists five data blocks, and each data block stands for one Modbus Master Request.  
 

Item Function Code Modbus Request Description 

1 2 Read Input-bits Read the DI data  

2 5 Write single coil-bit Write the DO data 

3 4 Read Input Registers Read the AI data 

4 6 Write single holding register Write the AO data (16-bit) 

5 16 Write Holding Registers Write the AO data (32-bit) 

 

5.1.1 Read the DI data 

1. Completing all the following settings in the “MODBUS Master Request” window, and then click “OK".  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

d. Activation: The way to send the Modbus request. 

Periodic:  Sending the request periodically. 

(In this case, to send once every two seconds.)   

“on error” means the next sending time when 

an exception occurred (e.g., 15 seconds).  

On call: The request is activated when a program 

makes function call. 

On change: In case of a write request, means that the request is activated each time a variable 

changes.  

e. Timeout:  Set a timeout value. (When time-out occurred, it will show the defined error code.) 

(The recommended value for the Modbus RTU/ASCII device is 200 to 1000 ms.  

In this case, the value is 250 ms) 

 

a. Slave/Unit:  

Enter the Net-ID of the Slave device. 

(In this case, the Net-ID is “1”). 

b.  MODBUS Request:  

Select “<2> Read Input Bits” option. 

c.  Base address: 

Start from “1” by default. 

Nb items:  

The number of DI signals to read. 

(In this case, the number is “16”). 

Note:  

If you want to change the “Base address”, 

right-click the “MODBUS Master” and 

then select the “MODBUS Master 

Addresses” to modify the value. 

 

a 

b 

c 

d 

e 

此選項不適用在 “讀取” 指令。 
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2. Next, open the “Variables” window and then declare variables that are available for the program.  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Declaring 16 variables to read data (Name: “Boo_01 to Boo_16”; Type: BOOL) and one array variable to 

record the state of data access  (Name: “Status"; Dim.: 5; Type: DINT). Refer the Sectin 2.3.1 for the 

way to declare variables , and the figure below shows defined variables.  

 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
3. In the "IO Drivers" window like the figure below, drag all required variables in the Variables Area (i.e., 

“Bool_01” to “Bool_16” and “Status”) and drop them to the “Symbol” area of the first data block.  

Note: The “Status” is an array variable, so, the Status[0] to Status[4] will show on the “Symbol” area. 

Click the “Del” key to delete the Status[1] to Status[4].  

 
4. Next, select “Offset” field from “Boo_01” to “Boo_16” and then click the “Iterate Property” button 

on the left side to set the “Offset” value (From: “0”；By: “1”, refer the Section 3.1 – Step8).  

 
 
 

Double click it to open the window. 

Tips:   
Press “F1” key to view the details 
on the MODBUS Master settings. 
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5. In the “Operation” field, set the “Status*0+” as “Error report” which means the return value is an 

“Error Code” if a read error occurred and the value will be reset to “0” if read successfully.  

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
You can also press “F1” in this “IO Drivers” window to see details on Modbus Master Configuration.  
 

Error Code Description Error Code Description 

0 The communication is OK.  8 Data Parity Error.  

1 MODBUS function not supported. 10 Invalid gateway path. 

2 Invalid MODBUS address. 11 Gateway target failed. 

3 Invalid MODBUS value. 128 Communication timeout. 

4 MODBUS Server failure.  129 Bad CRC16.  

6 Server is busy.  130 RS-232 communication error. 

 

Under construction ... 

3 

5 

4 

The “Offset” must be “0” when 
selecting the“Error report”. 
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5.2 Enabling the Win-GRAF PAC as a Modbus TCP/UDP Master 

Application Diagram: 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

(Refer the P1-1 to view all PAC models) 

Under construction ... 
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5.3 Connecting the Modbus TCP Slave Device with 2 IP Addresses 

Under construction ... 
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Chapter 6 Retain Variable and Data Storage 

Under construction ... 
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Chapter 7 Data Binding 

Under construction ... 
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Chapter 8 Linking DCON I/O Modules 

Under construction ... 
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Chapter 9 On Line Change 

"On Line Change" function allows Win-GRAF PAC change its application to a modified one during the 

PAC running time. The modified application must be the same name as the original one that currently 

running in the PAC. The "On Line Change" is primarily used for emergency, such as, when the application 

is not allowed to be disabled or stopped for a while or cannot find time to replace a new application (for 

example, the device needs 24 hours operation and cannot be stopped). Except the above situations, it is 

not recommended to use this function! You had better stop the running application, then download the 

modified application to the PAC (see Section 2.3.5), which is more safe. 

 
 
 
 
 
 
 
 
 
 
 

9.1 Limitations of "On Line Change"  

 
Please notice the important limitations before enabling the "On Line Change"! 
 
 

When On Line change is enabled, you can perform on the fly the following kinds of changes: 
 

 Change the code of a program.  

 Change the condition of a SFC transition or the actions of a SFC step. 

 
 
 
 
 
 
 
 
 
 
 

 Create, rename or delete global and local variables.  

 Create, rename or delete global and local function block instances. 

 
 
 
 
 
 
 
 
 

Sequential Function 
Chart (SFC) 

Step Action 

Step Step 

Transitions Transition 1 Transition 2 
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The following kinds of changes are not allowed: 
 

 Create, delete or rename a program. (It will appear a warning message if delete a program.) 
 
 
 

 
 
 
 

 Change SFC charts.  

 Change the local parameters and variables of a UDFB.  

 Change the type or dimension (or string length) of a variable or function block instance.  

 Change the set of I/O boards.  

 Change the definition of RETAIN variables. 

 
 
In addition, the following programming features that are not safe during a change should not be used: 
 

 Pulse (P or N) contacts and coils (edge detection). 

 Instead, you must use declared instances of R_TRIG and F_TRIG function blocks. 

 

Rising Pulse Detection 

P 
(False > True) 

Before Enable After Enable 

 

 

  

Decreased Pulse Detection 

N 
(True > False) 

 

 

  

 
 Loops in FBD with no declared variable linked. 

 You need to explicitly insert a variable in the loop. 
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9.2 Using "On Line Change"  

Enable The "On Line Change" Function: 

1. Mouse click "Project > Settings..." from the menu bar, then double click "On Line Change" item to set 

it "Enabled". 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
2. Click "Project > Build All Projects" from the menu bar. Must compile the program first, then can set 

up the following steps. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

This message can be ignored when just 
enable On Line Change. 
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Setup the Number of Variables: 
When the "On Line Change" is enabled, you have to set up the number of variables reserved for the 

declaration of the new variables and Function Blocks for future on-line change usage. 
 

3. The same as the step 1, mouse click "Project > Settings..." from the menu bar, then double click on 

the "On Line Change" to show the setting window. 

Please set the needed new number in the “Value" or “Margin" fields. 

Note:   If both “Value" and “Margin" have set values, it will use the larger value. In this example, 

"Value" is set as "30" and “Margin" is set as "10", then the displayed value x 10% is smaller 

than 30, so it will use the larger value "30". 
 

4. Click the needed Variable Type, then click the "Set“ button. 

 (E.g., Click "BOOL/SINT variables" and "Set" button, then the number become 9 + 30 = 39.)  

Note:   "STRING buffers (characters)", "FB instance data (bytes – approx.)" and "Complex variables 

segment (bytes) " need to set a larger number (This example uses "5000"). 
 

5. After setting (as the picture below), click the "X" in the upper right corner to exit the setting. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

6. Click "Project > Build All Projects" from the menu bar, compile the program again. Then click “On 

Line” or click the tool icon    to link to the PAC. (Refer the Section 2.3.5.) 
 
 
 
 
 
 
 
 
 

These 3 Types 
need larger 

values. 
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7. After successfully link to the PAC, click the tool icon "Download changes" to download the program 

to the PAC. 
 

Note: "On Line Change" is only suitable for the program that just has a little change (Do not need 

to stop the application). If the program name is different from the running one in the PAC, 

the user has to stop and download the program again (refer the Appendix B).  

 
 
 
 
 
 
 
 
 
 
 
 
 
 
8. Click on the tool icon "Do On Line change" to execute the program. 
 

Note:  After executing the "On Line Change", there are some using restrictions for protecting the 

system normal operation (refer the Section 9.1). So, make sure the program is correct, then 

perform this function. 
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Chapter 10 Data/Type Conversion and Using the PAC Time 

10.1 AI Data Conversion 

If you are using AI modules in the PAC's Slot 0 to 7 (for example: I-8017HW), and want to convert the AI 

input signal (for example: "4 to 20 mA" or "0 to 10 V") to the user engineering value (for example: 0 to 

10000), refer the Section 4.3. However, if you are using the remote AI modules (e.g., through PAC's 

RS-485 Port to connect to the I-87017ZW or I-7017R module), you can refer the following settings: 

 
 
 
 
 
 
 
 
 
 
 
1. First, connect  "i_scale" in the "I/O Boards" window, and double click on "i_scale_x" to open the 

Properties window (refer the Section 4.2 for detail steps) 

Note: "I/O Boards" supports ONLY ONE "i_scale" (DO NOT connect 2 or more "i_scale"). 

   
2. Set up the number and value of the Conversion Function that need to be enabled. 

(E.g., Use Function 1 to convert "4 to 20 mA" into "0 to 10000"). 

 

Ch01_X0_Min_Physical_Val:  “4.0” 

Ch01_X1_Max_Physical_Val:  “20.0” 

Ch01_Y0_Engineering_Val_For_X0:  “0.0”    

Ch01_Y1_Engineering_Val_For_X1:  “10000.0” 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
Win-GRAF PAC 

COMx: RS-485 

Data + 

Data - 

 

 
I-7017R 

Data + 

Data - 

 

 
I-87K4 I/O Expansion Unit 

+ I-87017ZW 
Data + 

Data - 
   
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3. Edit an ST Program to convert a physical value (e.g., Phy_V[0] to [7]) to an engineering value  

(e.g., Eng_V[0] to [7]). (Refer the Section 2.3.3 for detail setting steps.) 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

10.2 AO Data Conversion 

If you are using AO modules in the PAC's Slot 0 to 7 (for example: I-8024W), and want to convert the 

engineering value to the AO output signal (e.g., convert "0 to 20000" to "0 to 10 V"), refer the Section 

4.4. However, if you are using the DCON remote AO modules (e.g., through PAC's RS-485 Port to 

connect to the I-7024 module), you can refer to the following settings: 

 
1. Connect  "i_scale" in the "I/O Boards" window, and double click "i_scale_x" to open the Properties 

window (refer the Section 10.1 for detail steps) 

Note: "I/O Boards" supports ONLY ONE "i_scale" (DO NOT connect 2 or more "i_scale"). 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

   

(* ii is declared as DINT variable 
    Phy_V is declared as REAL array with Dim. = 8 
    Eng_V is declared as REAL array with Dim. = 8     *) 
 

 for ii := 0 to 7 do 
     
     (* Using conversion function 1 to convert a physical value to an engineering value *) 

     Eng_V[ii] := Convert_to_Eng (1, Phy_V[ii]); 
     
 end_for; 
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2. Set up the number and value of the Conversion Function (e.g., use Function 2 to convert "0 to 20000" 
to "0 to 10 V"). 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

3. Edit an ST Program to convert an engineering value to a physical value (e.g., Eng_V[0] to [7]).  

(Refer the Section 2.3.3 for detail setting steps.)  

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Ch02_X0_Min_Physical_Val is set as “0.0”. 
Ch02_X1_Max_Physical_Val is set as “10.0”. 
Ch02_Y0_Engineering_Val_For_X0 is set as “0.0”.    
Ch02_Y1_Engineering_Val_For_X1 is set as “20000.0”. 

(* ii is declared as DINT variable. 
    Phy_V is declared as REAL array with Dim. = 8 
    Eng_V is declared as REAL array with Dim. = 8  *) 
 

 for ii := 0 to 7 do 
      
      (* Using conversion function 2 to convert an engineering value to a physical value *) 

 
     Phy_V[ii] := Convert_to_Phy (2, Eng_V[ii]); 
      
 end_for; 
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10.3 Data Type Conversion 

When different types of data want to do "+, -, *, /" calculation or ">, <, =, <=, > =, <> (not equal)" 

operation, or when the variable types of the parameters in the function are different, you must first use 

the type conversion function (in the following table) to convert them into the same data type, then can 

use the data normally. 

 

Data Conversion 
Functions 

Descriptions 
Data Conversion 

Functions 
Descriptions 

ANY_TO_BOOL Convert to Boolean ANY_TO_REAL Convert to Real 

ANY_TO_SINT Convert to Short Integer (8-bit) ANY_TO_LREAL Convert to Double 

ANY_TO_INT Convert to Integer (16-bit) ANY_TO_STRING Convert to String 

ANY_TO_DINT 
Convert to Long Integer (32-bit – 
Default) 

NUM_TO_STRING 
Convert Number to String. 
Can set the decimal digital 
number after converting 

ANY_TO_LINT Convert to Large Integer (64-bit)  ATOH 
Convert Hexadecimal 
String to Integer 

ANY_TO_TIME Convert to Timer HTOA 
Convert Integer to  
Hexadecimal String 

 
For example, the following ST program will convert the DINT variable to a Real first, and then do the 

calculation. 

 
 
 
 
You can open the "HTML Help" from the menu bar, and enter the searching key word you want to see 

the detail setup instructions. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

REAL_Val_1  :=  ANY_TO_REAL (DINT_Val_1) * 3.5 + 4.8; 
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10.4 BCD Conversion 

BCD 4-bit code is used to represent decimal numbers from 0 to 9. Suppose there is a decimal value 

"132", if converted to BCD code is "000100110010" and if converted to binary is 10000100 (e.g., 27 + 22 = 

128 + 4 = 132). 
 

Decimal 
BCD 

Descriptions 
23 22 21 20 

0 0 0 0 0 0 

1 0 0 0 1 20 = 1 

2 0 0 1 0 21 = 2 

3 0 0 1 1 21 + 20 = 3 

4 0 1 0 0 22 = 4 

5 0 1 0 1 22 + 20 = 5 

6 0 1 1 0 22 + 21 = 6 

7 0 1 1 1 22 + 21 + 20 = 7 

8 1 0 0 0 23 = 8 

9 1 0 0 1 23 + 20 = 9 

 
The function table below can be used for BCD (Binary Coded Decimal) value conversion. 
 

Type Conversion 
Function 

Descriptions 

BIN _TO_BCD Convert Binary to BCD value 

BCD_TO_BIN Convert BCD value to Binary 

 
 
 
 
 
 
 
 
 
 
 
You can open the "HTML Help" from the 

menu bar, and enter the searching key word 

you want to see the detail setup 

instructions. 

 
 
 
 
 
 
 
 
 

NOTE:  
BCD code can only represent 
numbers from 0 to 9.  
It can not be used for these six 
values (1010, 1011, 1100, 1101, 
1110, 1111), and will return "0". 

BIN _TO_BCD: 
19(10) = 0001 1001(BCD) 
 =  24 + 23+ 20 =  16 + 8 + 1 = 25 

BCD_TO_BIN: 
33(10) = 0010 0001(2)  = 21(BCD) 

15(10) = 0000 1111(2)  = 0(BCD) 
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10.5 Pack/Unpack Integer or Boolean 
 

Unpack Integer to Boolean: 
 

If want to unpack one BYTE (or USINT, range: 0 to 255) to 8 Booleans, you can use "UNPACK8" Function 

Block. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
If want to unpack one SINT to 8 Booleans, you must first use the ST program "ANY_TO_BYTE ()" to 

convert the SINT to be a BYTE type, as follows: 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Pack Boolean Into Integer: 
 

If want to pack 8 Booleans into one BYTE (or USINT, range: 0 to 255), you can use "PACK8" Function. 
 

ST Program: 
 
 
 
 
 

USINT_1  :=   PACK8 (Bool_0, I Bool_1, Bool_2, Bool_3, Bool_4, Bool_5, Bool_6, Bool_7); 
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LD Program: 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
If want to pack 8 Booleans into one SINT, you must assign a "BYTE" variable to the output(Q) to save the 

value temporary, and use a "ANY_TO_SINT" Function to convert BYTE into SINT type, as follows: 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
Note:  If the compiling fails, please click "Project" > "Settings" from the menu bar to check if the setting 

of "Complex variables in a separate segment" in the "Runtime" is "Yes". 
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10.6 Pack/Unpack BYTE, WORD, DWORD 
 

Pack Two 8-bit Data into One 16-bit Data 
 

If want to pack 2 BYTE (or USINT) into one WORD (or UINT), you can use a "MAKEWORD" Function. 
 
ST Program: 
 
 
 
 
LD/FBD Program: 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
If want to pack 2 SINT into one INT, you must first use an ST program "ANY_TO_BYTE ()" to convert SINT 

into BYTE, and then use an "ANY_TO_INT" Function to convert the packed WORD into INT type. 

 
 
 
 
 
 
 
 
 
 
Unpack One 16-bit Data to Two 8-bit Data 
 

If want to unpack one WORD (or UINT) to 2 Byte (or USINT), you can use  "HIBYTE", "LOBYTE" Functions. 
 
 
ST Program: 
 
 
 
 
 
 
 

WORD_VAL_1  :=   MAKEWORD (Hi_byte, Lo_byte); 

Hi_byte  :=   HIBYTE (WORD_VAL_1); 
Lo_byte  :=   LOBYTE (WORD_VAL_1); 
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LD/FBD Program: 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
If want to unpack one INT to 2 SINT, you must first use an ST program "ANY_TO_WORD()" to convert INT 
into WORD, and then use an "ANY_TO_SINT" Function to convert the unpacked BYTE into SINT type. 
 
 

 
 
 
 
 
Pack Two 16-bit Data into One 32-bit Data 
 

If want to pack 2 WORD (or UINT) into a DWORD (or UDINT), you can use a "MAKEDWORD" Functions. 
 
ST Program: 
 
 
 
LD/FBD Program: 
 
 
 
 
 
 
 
 
 
 
 

DWORD_VAL_1  :=   MAKEDWORD (Hi_word, Lo_word); 
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If want to pack 2 INT into 1 DINT, you must first use an ST program "ANY_TO_WORD()" to convert INT to 
WORD, and then use an "ANY_TO_DINT" Function to convert the unpacked DWORD into DINT type. 
 
 
 
 
 
 
 
 
Unpack One 32-bit Data to Two 16-bit Data 
 

If want to unpack one DWORD (or UDINT) to 2 WORD (or UINT), you can use  "HIWORD", "LOWORD" 

Function Blocks. 

 
ST Program: 
 
 
 
 
LD/FBD Program: 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
If want to unpack one DINT to 2 INT, you must first use an ST program "ANY_TO_DWORD()" to convert 

DINT to DWORD, and then use an "ANY_TO_INT" FB to convert the unpacked WORD into INT type. 

 
 
 
 
 
 
 
 
 
 
 
 
 

Hi_word  :=   HIWORD (DWORD_VAL_1); 
Lo_word  :=   LOWORD (DWORD_VAL_1); 
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10.7 Unpack Variable to Byte Array or Pack Byte Array into Variable 

"SerializeOut" Function can unpack a Win-GRAF Variable value to a Byte Array (or USINT Array); 

"SerializeIn" Function can pack a Byte Array (or USINT Array) into a Win-GRAF Variable value. 

 

Note:  1.  The Dim. of Array must be set as at least "8". 

        2.  This "Serialize" Function can not use the STRING variable. 

 

You can open the "HTML Help" from the menu bar, and enter the searching key word to see the detail 

setup instructions. 

 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
If the SerializeOut() and SerializeIn() return "0", it means the saving location is wrong or the Array‘s 

space is not enough. 

 
(* Declare  TMP_DINT as a DINT,  

buf as a BYTE Array, Dim. = 10, 
DINT_Val as a DINT, 
Word_Val as a WORD, 
REAL_Val as a REAL  *) 

 
 
Example 1 
 
(* To unpack one DINT_Val to 4 Bytes, and save them separately to the buf[2], buf[3], buf[4] and buf[5] 

from the location 2 of the BYTE Array in the "Little Endian" sequence.  *) 

 

 
 
 
 
Note:  The last parameter is "FALSE", that means to use the "Little Endian" sequence (To save the Low 

Byte to the starting address). 

 
 
 

Note: 

Data Type Byte 

BOOL, SINT, USINT, BYTE 1 

INT, UINT, WORD 2 

DINT, UDINT, DWORD, REAL 4 

LINT, LREAL 8 

 

TMP_DINT  :=  SerializeOut (buf, DINT_Val, 2, FALSE) ; 
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Example 2 
 
(* To unpack one Word_Val to 2 Bytes, and save them separately to the buf[0] and buf[1] from the 

location 0 of the BYTE Array in the "Big Endian" sequence.  *) 

 
 
 
 
 
Note:  The last parameter is "TRUE", that means to use the "Big Endian" sequence (To save the High 

Byte to the starting address). 

 
 
Example 3 

 

(*  To pack the buf[0], buf[1] , buf[2] and buf[3] in the BYTE Array into one REAL_Val in the "Little 

Endian" sequence.  *) 

 
 
 
 
 
Note:  The last parameter is "FALSE", that means to use the "Little Endian" sequence (To save the Low 

Byte to the starting address). 

 
 
 
Example 4 

(*  To map one DINT_Val to one REAL_Val in the "Little Endian" sequence.   *) 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

TMP_DINT  :=  SerializeOut (buf, Word_Val, 0, TRUE) ; 

TMP_DINT  :=  SerializeIn (buf, REAL_Val, 0, FALSE) ; 

TMP_DINT  :=  SerializeOut (buf, DINT_Val, 0, FALSE) ; 
TMP_DINT  :=  SerializeIn (buf, REAL_Val, 0, FALSE) ; 
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10.8 Get/Set the PAC Time 

If you want to get the current time of a Win-GRAF PAC, you can use a "TIME_GET" Function Block.  

(Refer the Section 2.2.1) 

 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
If want to adjust the Win-GRAF PAC time, you can use "TIME_SET" Function Block. (Refer the Section 

2.3.6) First, fill the new time to the variables of "new_Year", "new_Month", "new_Day", 

"new_WeekDay", "new_Hour", "new_Minute" and "new_Second", then set the "Set_new_time" to 

"TRUE" one time. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

PAC_Year, PAC_Month, 

PAC_Day, PAC_WeekDay, 

PAC_Hour, PAC_Minute, 

PAC_Second are declared as 

DINT 

Set_new_time is declared as BOOL 

new_Year, new_Month, new_Day, 

new_WeekDay, new_Hour, 

new_Minute, new_Second are 

declared as DINT 
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Chapter 11 Commonly Used Tools and Useful Tips 

11.1 Upgrade Win-GRAF Libraries 

Note: We will provide a web link for the libraries in the future. 

 

The Win-GRAF Libraries (Including Function, Function Block and I/O Board definitions) are saved in the 

folder of “ICP DAS - XP-WP-VP” under the directory of “C:\Win-GRAF\DATA\HWDEF”.  

 

In some situations, you need to upgrade the Win-GRAF Libraries to the new version for supporting more 

Functions or new I/O Board. Please follow the steps below: 

 

1. First, close all Win-GRAF Workbench windows. 

2. You can compress the original “ICP DAS - XP-WP-VP” folder and backup to other directory (ex: 

D:\temp\xxx.zip), and then delete the folder. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
3. Copy the new “ICP DAS - XP-WP-VP” folder into the directory “C:\Win-GRAF\DATA\HWDEF”, and 

execute the Win-GRAF Workbench again. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Delete the folder after back up. 
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11.2 Upgrade Win-GRAF Driver 

Note: We will provide a web link for the Drivers in the future. 

 
For updating add-on functions, I/O boards or other purposes, ICP DAS will release a new version of 
Win-GRAF drivers in the future. Please get the latest version from the website and follow the steps 
below to upgrade the new driver into the PAC.  
 
The Win-GRAF Driver of the XPAC (XP-8xx8, XP-8xx8-CE6, XP-8xx8-Atom-CE6), WinPAC (WP-8xx8, 
WP-5xx8) and ViewPAC (VP-25W8, VP-4138) will be placed in the directory "\System_Disk\Win-GRAF\" 
inside the PAC.  
 
1. On the desktop of a PAC (use WP-8xx8 in this example), double click on the "Win-GRAF_WP_8000" 

icon and then click "End Driver" to stop the currently running driver. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
2. In the PC, copy the new driver into the PAC's directory “\Temp\” by using FTP method.  
 

3. In the PAC, copy the new driver from “\Temp\” into “\the System_Disk\Win-GRAF\” directory to 

replace the old one, and then reboot the PAC. 
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11.3 Spy List 

When a program is running, the Spy List lets users quickly know the variable’s value or status. 

Sometimes, a program may declare hundreds or thousands of variables, users do not need to look for 

them, just simply switch to the pre-created Spy List window to see the wanted information. 

 

Steps: 

1. Right-click on the project name (e.g., "Demo01") and select "Insert New Item". 

2. Select "Spy List" of the "Watch", then click "Next" to the next step. 

3. Then, key in a list name (e.g., "NewSpy1") and press "OK". 

 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

1 

2 

3 
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4. Double click "NewSpy1" on the left side to open the setting window and drag the variables you want 

to put into the window. 

 
 
 
 
 
 
 
 
 
 
 
 
5. When the Win-GRAF and the PAC are connected, the "NewSpy1" window will show the variables 

information clearly. 
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11.4 Backup/Restore a Win-GRAF Project 
 

Backup A Win-GRAF Project: 

1. Mouse right-click on the project name (e.g., "Demo01") and select "Save Project" and then "To Disk". 

 
 
 
 
 
 
 
 
 
 
 
 
2. Click on the "Browser" button to assign a directory you want to save the project (e.g., 

D:\Win-GRAF_demo_backup), fill in the project name (e.g., "Demo01_0613"), and then click "OK" to 

backup the project. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Restore A Win-GRAF Project: 

1. Copy the previously backed up the project folder (e.g., "Demo01_0613") into 

"C:\Win-GRAF\Projects". 

 
 
 
 
 
 
 
 
 
 
 
 

1 

2 
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2. Click the menu bar "File" > "Close Project List" to close all opened project windows. 

 
 
 
 
 
 
 
 
 
3. Click the menu bar "File" > "Add Existing Project" > "From Disk", select the project you want (e.g., 

"Demo01_0613") in the "C:\Win-GRAF\" directory, and then click "OK" to restore the project.  
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11.5 Software Reboot a PAC 

Based on some cases, users may want to reboot the PAC in a software way. The Win-GRAF provides a 

Function "PAC_Reboot" for users to restart the PAC. 

 
Note:  Please DO NOT call this Function in every PAC Cycle, or the PAC will reboot all the time. 
 
Safety Coding: 
 
  (*  "reset_PAC" is declared as BOOL and has initial "FALSE"  

        "TMP_BOOL" is declared as BOOL *) 

   (* ONLY when "reset_PAC" is set to "TRUE", the PAC will reboot  *) 

   if  reset_PAC  then 

      reset_PAC := FALSE ; 

      TMP_BOOL  :=  PAC_Reboot( ) ; 

   end_if ; 

   
 
Dangerous Coding: 
 
    (*  "TMP_BOOL" is declared as BOOL *) 

  (* Dangerous ! This coding method will let the PAC reboot always and cannot stop. *) 

   TMP_BOOL  :=  PAC_Reboot( ) ;  

 
If a mistake to reboot the PAC always, turns the rotary switch of the Win-GRAF PAC to "1" and reset it. 

Then it will boot up in safe mode. Then you may rename the Win-GRAF application code in the PAC to 

an invalid name. Then when the rotary switch is turned back to "0" and reboot, it will boot up normally 

(No application). The Win-GRAF application code in the XP-8xx8, XP-8xx8-CE6, WP-8xx8, WP-5xx8, 

VP-25W8 and VP-4138 is "\System_Disk\Win-GRAF\t5.cod". 
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11.6 Using ST Syntax in LD and FBD 

The Win-GRAF Workbench allows users using simple ST syntax in Ladder (LD) and Function Block 

Diagram (FBD) to facilitate programming. Before use, go to the menu bar "Project"> "Settings" > 

"Runtime", and set the "Complex variables in a separate segment" to "Yes" to enable this function. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Example: 
 
LD Program: 

Using division (REAL_VAL/25.5). 

 
 
 
 
 
 
 
FBD Program: 

Call a function "ANY_TO_BYTE()" to convert the type from "SINT" to "BYTE". 
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11.7 Apply a Recipe in the PAC 

Some applications use the pre-defined Recipe and Value for processing different products, and this 

Recipe can be mapped to a combination of variables within a Win-GRAF PAC. When one day want to 

change the PAC process to produce a different product, you can use the Win-GRAF Workbench to 

connect with the PAC and select a new Recipe you want to replace, and then apply it to the PAC. 
 

Steps: 

1. Mouse right-click on the project name (e.g., "Test") and select "Insert New Item"; then click on 

"Watch" > "Recipe" and "Next" button, fill in the Recipe name (e.g., "NewRecipe1") and then click 

"OK". 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

2. Double click "NewRecipe1" on the left side to open the setting window and drag the variables you 

want to put into the window. 

 
 
 
 
 
 
 
 
 
 
 
 
 

1 

2 

3 
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3. Click on the "Insert Column" icon to add the new Recipe, and then fill in the suitable Values. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

4. Click on the "On Line" button to connect the PAC. At first the Values are all "0", please select the 

product column and then click the icon "Send Recipe" to apply this Recipe into the PAC. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Note:  If want to save the Values in 
the PAC (e.g. Power off and restart 
the PAC, the Recipe can still retain 
the previous Values), please refer 
the method of using the retain 
variables in the Section 6.1. 
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11.8 Get the Functions and Function Blocks that Supported by the PAC 

In the Win-GRAF Workbench window, user can expand the "All" directory in the "Blocks" panel to see 

quite a lot of Functions and Function Blocks, however, some are not supported in the Win-GRAF PAC. 

The following will show how to quickly get the Functions or Function Blocks that supported by the PAC. 

 

 
 
Setting Steps: 
 

1. Make sure the PAC is powered on and connected with a PC via an Ethernet cable. 

2. In the Win-GRAF Workbench, right-click on the project name (e.g., "Demo01") and then select 

"Configuration", and click on the "Upload" button in the "Select" tab to open the setting window.  

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

“Blocks” 
Panel 

Project 
Name Expand 

"All" 
Directory 

Click  "Upload" 

Right-click 
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3. Configure/Select the IP address of the PAC and click on "OK" button, the PAC will upload the 

configuration file. Next, key in the file name (e.g., "test.cfg") and click "Save" to save the 

configuration file. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

4. Back to the "Configurations" window, the configuration file (test) will show in the list, and then click 

"OK" to leave this window. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Setup the IP addr. of the PAC  

Upload the configuration 

Give the file name & save it. 

Save file under C:\Win-GRAF\DATA\CONFIG 
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5. In the "Blocks" panel, the red Functions and Function Blocks are not supported by this PAC. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

“Blocks” Panel 

Red means PAC 
does not support. 
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11.9 Upload the Win-GRAF Source Code 

For some applications, users need to get the source code of the Win-GRAF project from the PAC to the 

PC, this is called "Upload". This function can prevent the project source code from missing or incomplete 

handover from the previous worker, you can still get the project source code inside the PAC. 

 
Enable/Download The Project Source Code: 
1. Click on the menu bar "Project" > "Settings" to open the setting window. 

2. Double click on the "Download procedure" of the "Debugging" and select "Send source code for 

later project upload", and then click "OK ". 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

3. Click on the menu bar "Project" > "Build All Projects" to compile the program, and then click on the 

tool icon   to connect the PAC, and next, download the current project to the PAC. (Refer the 

Section 2.3.5 for the detail steps). After downloading, the source code will be stored in the file of the 

directory "\Systen_Disk\Win-GRAF\t5.upl" of the PAC. This file will be larger when the project 

increases. If the project becomes very large and complex, the file size may reach several hundreds K 

Bytes or even more than 1 MB.  

 
 

Note: When the "Upload" is enabled, 
it means to store the source code in 
the PAC. If someone gets this PAC, he 
may have the opportunity to get your 
source code. 
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Upload the Porject Source Code: 
Please close all opened Win-GRAF windows (Click on the menu bar "File" > "Close Project List"). 

4. Click on the menu bar "File" > "Add Existing Project" > "From Target", then select the PAC‘s IP 

address and set up the upload file name (e.g., "UPL_project1"), and then click "OK" to upload the 

file. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
5. After uploading, click on "OK" button, and then the Win-GRAF will open the project automatically. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Select PAC IP 

Set up the upload file name 
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11.10 Set Up the PAC Password 

In order to avoid the important program running in the PAC is changed or stopped by an unfriendly 

connecting PC, you can set up a password for the PAC to prevent unauthorized operation. 

 
1. Click on the menu bar "Project" > "Settings" to open the setting window. 

2. Double click on the "Runtime password" of the "Compiler", set a password, and then click "OK". 

 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
3. Click on the menu bar "Project" > "Build All Projects" to compile the program again, and then 

download the current project to the PAC (Refer the Section 2.3.5 for detail steps.). When the next 

time to click the "On Line" icon for connection, it will require the password. 

 

 
 
 
 
 
 
 
 
 
 

Set a password 

If click "On Line", it need the password. 
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Note:  After enabling the password, please remember your password, or you will not connect the PAC. 
 
The Only Solution: 
 
1. Connect the PAC with a USB mouse and screen. 

2. In the PAC, execute the Win-GRAF Driver and then click on "End Driver" button. 

 (Refer the Section 11.2). 

 
 
 
 
 
 
 
 
 
 
 
 
 
 

3. Rename the file "t5.cod" in the directory "\System_Disk\win-graf" (e.g., "t5.cod1") or delete it. Then 

reboot the PAC.  

 
 
 
 
 
 
 

Then, it will become "No application" in the PAC. Now, you can connect and download the 

application from the Win-GRAF Workbench again. 
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11.11 Using Function Block in the ST Program 

It is easy to use the Function in the ST program, just call the Function and assign the corresponding 

parameters. The example below will open COM3 at the beginning, and then send a String `Hello‘ from 

COM3 every 5 seconds. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
To use a Function Block in the ST, you must first declare an Instance Variable of the Function Block in the 

variable region, after that, the using steps are similar to the steps of using the Function, as follows:  

 

The following code can unpack one Byte to become 8 BOOLs:  

1. Declare "MyUnpack" variable as "UNPACK8" (FB Instance) and "IN" variable as "BYTE". 

  
 
 
 
 
 
 
2. Edit an ST program. 
 

MyUnpack(IN) ; 

Q0  :=  MyUnpack.Q0 ; 

Q1  :=  MyUnpack.Q1 ; 

Q2  :=  MyUnpack.Q2 ; 

Q3  :=  MyUnpack.Q3 ; 

Q4  :=  MyUnpack.Q4 ; 

Q5  :=  MyUnpack.Q5 ; 

Q6  :=  MyUnpack.Q6 ; 

Q7  :=  MyUnpack.Q7 ; 

 

(* Declare  “INIT1” as BOOL and has initial value TRUE,  
Declare  “TMP_BOO” as BOOL,  “TMR1”  as TIME  *) 

 

IF     INIT1     THEN 

    INIT1  :=  FALSE ; 

        TMR1  :=  T#0s ; 

    TSTART  (TMR1) ; 

END_IF; 

IF  COM_Status(3) = FALSE  THEN 

    TMP_BOO := COM_open (3, `19200,N,8,1’) ;  

END_IF ; 

IF     TMR1  >=  T#5s     THEN 

TMR1  :=  T#0s ; 

     COM_send_str (3, `Hello: ’) ; 

END_IF; 
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11.12 How to Protect Your Win-GRAF Program to Avoid Unauthorized 
Copied? 

When you finish a Win-GRAF application development and prepare for delivery to the customer, please 

think about the possibility that your Win-GRAF application in the PAC may will be copied into another 

same model PAC?! Be careful! Someone else may steal your hard outcome! The following provides a 

simple and easy way to protect your application. 

 

Note:  If you give the Win-GRAF application Source Code to the customer, then sorry, the following 

method will not protect your program from stolen. Because having the Source Code, anyone can 

modify the code and apply into another PAC. 

 

Each ICP DAS Win-GRAF PAC has a Serial Number that has 8 Bytes (also known as 64-Bit), and each PAC 

has the different and unique Serial Number. Therefore, you can use this serial number combine with 

your own algorithm to generate a password, and pre-store this password into the PAC's EEPROM. Then, 

verify this password in your application. If not passed, the application will not be allowed to execute.  

 

The steps are as follows: 

This example uses two Win-GRAF projects, one is "demo_passwd" used to generate a PAC password and 

save it into the EEPROM; the other is "demo_my_ap" that is a developed application and ready to ship 

to the customer. Before shipping a PAC to the customer, user needs to download the project 

"demo_passwd" into the PAC and runs it once to generate a unique password for that PAC. Then, 

downloads the project "demo_my_ap" into the same PAC, and then can ship the PAC to the customer. 

After that, if someone copies the Win-GRAF application in this PAC to another same type of PAC and the 

operation will fail because of the password validation failure. 

 

There are two example projects (demo_passwd.zip and demo_my_ap.zip) in the shipment CD 

(\Napdos\Win-GRAF\demo-project), please refer the Chapter 12 to restore the projects (Execute File > 

Add Existing Project > From Zip) and set up the IP address of the current PAC. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

變數區 
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"demo_passwd" Project: 
 
This program first uses "PAC_SN" Function to read out the Serial Number, and then uses a user-defined 

algorithm to generate a password. Finally, save the password to an address within the EEPROM memory 

(user can decide where you want to store). 

 
Variable Declaration: 
 
 
 
 
 
 
 
 
 
 
 
 
 
ST Program: 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

(*  This "demo_passwd" example will generate a password by the 8-Byte Serial Number of the PAC 
and save it into the EEPROM of the PAC *) 

 
(*  Declare  "No_0" ~ "No_7" and "password"  variables as  DINT. 

 Declare  "INIT" variable as BOOL and has Initial value TRUE. *) 
 
(* Operations in the first PAC Cycle *) 
if  INIT  then 
       INIT := FALSE ; (* No more first cycle *) 
 
   (* Get the hardware serial number *) 
   PAC_SN( No_0, No_1, No_2, No_3, No_4, No_5, No_6, No_7) ; 
 
  (*  Please use your own algorithm to generate a password. This example generate only one 

password. You may change it to generate some passwords.  *) 
   password := (No_0 * No_1) + (No_2 * 12345) + No_3 +  (No_4 * No_5) + No_6 + No_7 ; 
 
   (* Save the password into the EEPROM, address is "157" *) 
   EEP_Write( 157 , password ) ;  
      
end_if ; 
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"demo_my_ap" Project: 
 
This project first uses "PAC_SN" Function to read out the Serial Number, then calculates the password, 

and then compares the password that read from EEPROM to check if the password correct. 

 
 
 
 
 
 
 
 
 
  
   
(Note: Refer the Section 2.1.2 to arrange the programs in the execution order.) 
 
Variable Declaration: 
 
 
 
 
 
 
 
 
 
 
 
 
 
ST Program - Main: 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

(* This "demo_my_ap" example can read the password from the EEPROM of the PAC, and check if 
match with the result that calculated from the user’s own algorithm.  *) 

 
(* Declare  "No_0" ~ "No_7", "password" and "PAC_password" variables as  DINT. 

Declare  "INIT" variable as BOOL and has initial value TRUE. 
Declare  "password_ok" variable as BOOL  *) 

 
(*  Operations in the first PAC cycle  *) 
if  INIT  then 
       INIT := FALSE ;  (*  No more first cycle  *) 
 
   (*  get the hardware serial number  *) 
   PAC_SN( No_0, No_1, No_2, No_3, No_4, No_5, No_6, No_7) ; 
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LD Program – LD2 
 
If the "password_ok" is “FALSE“, it means the password is incorrect, then will exit the program. Only 

when the password is correct can the program execute continuously, and then your application can be 

protected from the unauthorized access.  

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

   (*  Please use your own algorithm for the "PAC_password" value  *) 
  PAC_password:=  (No_0 * No_1) + (No_2 * 12345) + No_3 + (No_4 * No_5) + No_6 + No_7 ; 
 
   (*  read the pre-saved password from the EEPROM, address is "157"  *) 
   EEP_Read( 157 , password ) ;  
    
   (*  check if the password is correct?  *) 
   password_ok := FALSE ;  (*  set it as "FALSE" in the beginning *) 
   if  password = PAC_password  then 
      password_ok := TRUE ;   (*  the password is correct  *) 
   end_if ; 
      
end_if ; 

This example uses only one 
"LD2" program, if your 
application as well as other 
programs, please add the 
"password_ok" checking code 
for each program. 
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Chapter 12 Demo Project Descriptions 

There are some demo projects in the Win-GRAF shipping CD (CD-ROM: \Napdos\Win-GRAF\ 

demo-project) which some of them will be introduced in the following sections.  

Before using the demo projects, follow the steps below: 
 

1. Click on the menu bar "File" > "Add Existing Project" > "From Zip" to open a project (e.g., 
"demo_tmr1.zip"). 

 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
 
 
 
 
 
 
 
 
 
2. Double click "Main" to open the ST program, and can view/add variables in the variable area. 
3. Mouse right-click on the project name (“demo_tmr1“), and select  "Communication Parameters" to 

set up the IP Address of your PAC. (Refer Section 2.3.5) 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

CD-ROM: 
\Napdos\Win-GRAF\demo-project 

Note! 
Please close the current "project List" 
before restoring the demo projects in the 
CD-ROM. (Click on the menu bar: "File" > 
"Close Project List") 
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12.1 Timer Operations 

12.1.1 Start, Stop and Reset the Timer 

Refer P12-1 to open the project ("demo_tmr1.zip"), and can view/add variables in the variable area. 
 
ST Program: 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

(* Declare “START_tmr”,  “STOP_tmr”,  “RESET_tmr”,  “LED1”,  “LED2” as BOOL  
     Declare “TMR1” as TIME  *) 
(* Set  START_tmr as TRUE to start ticking Timer TMR1  *) 

 IF     START_tmr     THEN 

    START_tmr  :=  FALSE ; 

    TSTART  (TMR1) ; 

END_IF; 

 

(* Set STOP_tmr as TRUE to stop ticking Timer TMR1  *) 

IF     STOP_tmr     THEN 

STOP_tmr  :=  FALSE ; 

    TSTOP  (TMR1) ; 

END_IF; 

 

(* Set RESET_tmr as TRUE to reset TMR1 to a value T#0s  *) 

IF     RESET_tmr     THEN 

RESET_tmr  :=  FALSE ; 

    TMR1  := T#0s ; 

END_IF; 

 

(* Let LED1, LED2 ON during TMR1 = 3 ~ 10 second  *) 

LED1  :=  FALSE ; 

LED2  :=  FALSE ; 

IF     (TMR1  >=  T#3s) and   (TMR1  <=  T#10s)   THEN 

LED1  :=  TRUE ; 

LED2  :=  TRUE ; 

END_IF; 

 

(*  Reset TMR1 as 0 when reachs 15 second  *) 

IF     TMR1  >=  T#15s   THEN 

TMR1  :=  T#0s ; 

END_IF; 
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12.1.2 Periodic Operations 

Refer P12-1 to open the project ("demo_tmr2.zip"), and can view/add variables in the variable area. 
 
Function "BLINK" plus Function Block "F_TRIG" can produce a Pluse TRUE at regular intervals, so it can 
be applied in the periodic operations. 
 
LD Program: 
 
 
 
 
 
 
 
 
ST Program: 
 
 
 
 
 
 
 
 
The "BLINK" and "F_TRIG" above will produce a Pluse TRUE every two seconds, but this method has a 
drawback: 
 
 
 
 
 
 
 
 
If the interval time of the period is shorter (e.g., 100 ms per period or less; or the PAC Cycle Time is 
larger, such as 20 ~ 50 ms, generally 3 ~ 15 ms), then the period operations will be inaccurate. For 
example, to do a periodic operation every 50 ms, as compared to 250 ms or 2 seconds, the interval time 
of 50 ms is very close to the PAC Cycle Time, if using Function Blocks "BLink" plus "F_TRIG", it is easy to 
accumulate the output delay time, therefore the final operation time will become inaccurate. 
 
 
 
 
 
 
 
 
 

 IF    pluse1   THEN 

    (*  do periodic operations here *) 

    

END_IF; 

2 Sec 2 Sec 

pluse1 

50 ms 

pluse 

50 ms 

Delay: 5 ms   10 ms  ……. : Cycle time 
  (3 ~ 15 ms) 

Type: BOOL 

Tolerance will increase. 

javascript:void();
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To improve the situation above, the following coding method will be more accurate: 
 (Tolerance will not increase.) 
 
Refer P12-1 to open the project ("demo_tmr3.zip"), and can view/add variables in the variable area. 
 
ST Program: 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

(* Declare “INIT”  as BOOL and has initial value  TRUE  
    Declare “TMR1”,  “TMR1_next” as TIME  *) 

 

 IF   INIT   THEN 

     INIT  :=  FALSE ; 

     TMR1  :=  T#0s ; 

TMR1_next  :=  TMR1  +  T#50 ms ; 

TSTART (TMR1); 

END_IF; 

 

IF   TMR1  >=  TMR1_next   THEN 

     IF   TMR1  >  T#10h  THEN 

           TMR1  :=  T#0s ; 

           TMR1_next  :=  T#0s ; 

END_IF; 

TMR1_next  :=  TMR1_next  +  T#50 ms ; 

(*  Do periodic operations here *) 

   

END_IF; 

 

When the timer reach T#23h59m59s999ms, 
the value will overflow.  
Therefore, please reset it automatically to 
"0" after 10 or 18 hours. 
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12.1.3 Detect the Steady ON or Steady OFF Signal 

"TON" Function Block can detect the steady "ON" signal. (Keeps "ON" for a minimum period of time.) 
 
 
 
 
 
 
 
 
As the picture above, this function can detect the steady "ON" signal that keep at least 2 seconds.  
 
 
 
 
 
 
 
 
 
 
"TOF" Function Block can detect the steady "OFF" signal. (Keeps "OFF" for a minimum period of time.) 
that can keep "OFF" for a period of time. 
 
 
 
 
 
 
 
 
As the picture above, this function can detect the steady "OFF" signal that keep at least 3 seconds. 
  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

IN_1 
2 sec 2 sec 

ON ON 

OUT_1 

ON ON 

PT: Programmed Time 
ET: Elapsed Time 

PT: Programmed Time 
ET: Elapsed Time 

IN_1 

3 sec 

OUT_1 

OFF OFF OFF 

3 sec 

OFF OFF OFF 

IN_1 
2 sec 2 sec 

ON ON 

OUT_1 

ON ON 
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12.1.4 Keep Outputting ON for Some Time after Triggering 
 

"TP" Function Block can keep outputting "ON" for some time after triggering (e.g., from OFF to ON). 
 
 
 
 
 
 
 
 
 
 
As the picture above, after triggering, it can keep outputting "ON" signal for 10 seconds. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

IN_1 

OUT_1 

ON 

10 sec 

ON 

10 sec 
10 sec 

PT: Programmed Time 
ET: Elapsed Time 
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12.2 Operations of Serial Port Communication  

Users can directly operate the serial port (e.g., RS-232, RS-485 or RS-422 Port) to achieve some specific 

communication protocol. The following Functions can be used to directly operate the serial port. 

 

Functions Descriptions 

COM_open Open a serial COM port. 

COM_close Close a serial COM port. 

COM_clear Clear the input buffer of a serial COM port. 

COM_test Test if any data received in the input buffer of a serial COMM port. 

COM_send Command a serial COM port to send 1~500 bytes.  

COM_send_str Command a serial COM port to send a String. 

COM_recv 
Receive bytes from the input buffer of a serial COM port and save 
them in a byte array. 

COM_status Get the current status of a serial COM port. 

 
Please refer Section 1.2.3 to open the Library Manager and find the detail Function descriptions.  
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12.2.1 Send a String by COM Port 
 

Refer P12-1 to open the project ("demo_com_port1.zip"), and view/add variables in the variable area. 
 

ST Program:   This program can send a String every 2 seconds by the PAC COM1 (parameters: 

`9600,N,8,1‘) (e.g., < CNT1 = 1 > or < CNT1 = 25 >). 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

(*  Operations in the first PAC cycle  *) 

if  INIT  then 

  INIT := FALSE ;  (*  No more first cycle  *) 

  CNT1 := 0 ; 

  TMR1 := T#0s ; 

  TMR1_next := TMR1 + T#2s ; 

  (* start ticking TMR1 *) 

  tStart(TMR1) ; 

end_if ; 
 

(* if the status of COM port becomes FALSE(not open), open it *) 

if  COM_Status(Port_number) = FALSE  then 

  (* open a serial COM port *)  

  Port_OK := COM_open(Port_number, '9600,N,8,1' ) ; 

end_if ; 
 

(* when time reached , ... *) 

if  TMR1 >= TMR1_next  then 
  
  (* to prevent TMR1 overflow (means reach T#23h59m59s999ms) *)   

  if  TMR1 > T#10h  then 

    TMR1 := T#0s ; 

    TMR1_next := T#0s ; 

  end_if ; 
  
  (* Set new TMR1_next *) 

  TMR1_next := TMR1_next + T#2s ; 
   
  (* Send a string from COM port *) 

  COM_send_str( Port_number, '<CNT1=' + Any_to_STRING(CNT1) + '>' ) ; 
   
  (* reset CNT1 when reach 100 *) 

  CNT1 := CNT1 + 1 ; 

  if  CNT1 >= 100  then 

    CNT1 := 0 ; 

  end_if ;   

end_if; 

Declare  “INIT”  as BOOL and has initial value TRUE;   
“Port_OK”  as BOOL  ;  
 “CNT1”  as DINT  ; 

                  “TMR1”,  “TMR1_next” as TIME  
 “Port_number” as  DINT  and has initial value “1” 
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12.2.2 Request/Answer the Device by COM Port 

If an application needs to use RS-232/485/422 Port to get the data from other devices, the steps are as 

the following request and answer: 

 
 
 
 
 
 
 
 
 
 
 
 
Refer P12-1 to open the project ("demo_com_port2.zip"), and view/add variables in the variable area. 
 
Note: Double click “Action” will first open a “Notes” window, then click “Action” icon to see the code. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
You can click the “Variables” tag to open the Variables window. 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
Win-GRAF PAC 

1. Send a command to request the Device. 
 

3. Check if receive the complete reply? 
(If yes, do the proper operations and  
wait for a while, and then return to  

the step 1 to send the next command.)  

 
Device 

2. Check if receive a complete query? 
(If yes, reply an answer to the  

Win-GRAF PAC.) 
 

4. Wait for the next command,  
and if receive a command  

then go to the step 2. 

1 

2 

Double click 

Notes 

Action 



Win-GRAF User Manual,  V 1.00,  Jul. 2014  by ICP DAS     12-10 

 

In this example, the Win-GRAF PAC sends a string 'QUESTION?' by COM3 to the device, and then wait for 
the reply and does operations. After the operations, waits 2 seconds, and then sends the same 
command 'QUESTION?', and repeated. 
 
SFC Program:   
( Declare  "Port_OK"  as BOOL ;   "NUM1" as DINT ;  "ByteAry"   as BYTE   and  Dim. = "200" ; 
             “Port_number” as  DINT  and has initial value "3" ) 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Action(P) : 

  (* if port is not open, open it *) 

  if  COM_status(Port_number) = FALSE  then 

    Port_OK := COM_open(Port_number, '9600,N,8,1' ) ; 

  end_if ; 

End_Action ; 

Port_OK  ; 

Action(P) : 
  (* Clear input buffer *) 

  COM_clear(Port_number) ; 
  (* Send 'QUESTION?' by COM3 *) 

  COM_send_str(Port_number, 'QUESTION?' ) ; 
End_Action ; 

GS3.T >= T#250ms ; 

Action(P) : 
  (* receive reply from COM3,max. 200 bytes in this example*) 

  NUM1 := COM_recv(Port_number, ByteAry, 0, 200) ; 
  (* do operations if protocols is correct *) 

  if  NUM1 = 10  then 
    (* ... *) 

  end_if ; 
End_action ; 

1 

2 

3 

4 

5 

6 

1 

(Open COM3 as `9600,N,8,1‘) 

(If succeeds, do the next.) 

(In this example, clear input buffer of 

COM3 first, and then send a 

command 'QUESTION?'.) 

(After sending query, wait for 250 ms to allow the device’ reply Bytes 

are safely delivered to the Win-GRAF PAC. Do not set the time too 

short, or cannot receive a full reply.) 

GS5.T >= T#2 ; (Put the received Byte into ByteAry[]  

and check if the number is correct? 

If yes, do the operations the 

application needed.) 
(When done, wait 2 seconds and then 

return to the step 1 to send the next 

query command.) 
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12.2.3 Wait Data Coming from Remote Device by COM Port 

This way is common in the general store or supermarket, such as using the barcode readers. After 

reading the barcode of the product, it will send the barcode data to the Win-GRAF PAC's COM Port 

(RS-232/485/422), and need not to reply any messages. 

 
 
 
 
 
 
 
 
 
Refer P12-1 to open the project ("demo_com_port3.zip"), and view/add variables in the variable area. 
 
 
ST Program: 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

(* operations in first PAC cycle *) 

if  INIT  then 

  INIT := FALSE ; 

  T1 := T#0s ; 

  STEP1 := 0 ; 

end_if ; 
 

(* if port is not open, open it *) 

if  COM_status(Port_number) = FALSE  then 

  Port_OK := COM_open( Port_number , '9600,N,8,1' ) ; 

end_if ; 
 

(* If open port fail, exit this ST program *) 

if  Port_OK = FALSE  then 

  return ; 

end_if ; 
 

CASE  STEP1  OF 
    
  (* if there is at least 1 byte coming *)  

  0:  

      if  COM_test(Port_number)  then 

        STEP1 := 1 ;  

        T1 := T#0s ; 

        Tstart(T1) ;   

      end_if ;       

STEP1 = 0, means waiting, and will test if COM3 has data? 

If returns TRUE, means COM3 has data.  

Then set STEP1 to "1", T1 to "0" and start timing. 

Declare "INIT" as BOOL and has initial value TRUE; 
  "Port_OK"  as  BOOL  ;  
  "STEP1", "NUM1"  as DINT ;  
  "T1" as TIME ;  
  "ByteAry" as BYTE and Dim. = "200" ; 
  “Port_number” as  DINT and has initial value "3". 

 
Win-GRAF PAC 

2. If receives the complete data from device,  
do operations. 

3. When done, wait for the next data coming. 

 
Device 

1. After triggering, send data to  
the Win-GRAF PAC 

1 
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    (* wait 250 ms, then receive all bytes form COM port *) 

  1:  

      if  T1 >= T#250ms  then 

        Tstop(T1) ; 

        T1 := T#0s ; 

        STEP1 := 0 ; 

         

        (* receive max. 200 bytes *) 

        NUM1 := COM_recv(Port_number , ByteAry , 0 , 200 ) ; 

         

        (* do proper operations if protocol is correct ,  

here assume correct protocols has 25 bytes in this example*) 

        if  NUM1 = 25  then    

          (* ... *) 

        end_if ; 

         

      end_if ; 

       

END_CASE ; 

STEP = 1: means the data is sending in, and will wait 250 ms 

to receive all data and put them into an array. The waiting 

time concerns the device specifications and the Baud Rate. 

If set the time too short, may receive data incompleted. 

Remember to set STEP1 to "0" to wait for the data coming 

next time. 

When receive data, check if data is correct?   

If yes, do the operations the application needed. 
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12.2.4 Report Data Periodically to Remote Device by COM Port 

If wants to periodically report data to other devices by RS-232/485/422 Port, do as follows. 

 
 
 
 
 
 
 
 
 
 
 
Refer P12-1 to open the project ("demo_com_port4.zip"), and view/add variables in the variable area. 

 

SFC Program:   (Refer Section 12.2.2 to open the "Action" window.) 

 

(Declare  “Port_OK“ as BOOL  ;   "TMP_DINT" as DINT   ;   "ByteAry" as BYTE and Dim. = 100   ;    

                “Port_number” as  DINT  and has an initial value  "2".) 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Action(P) : 
  (* if port is not open, open it *) 

  if  COM_status(Port_number) = FALSE  then 
    Port_OK := COM_open( Port_number , '19200,E,8,2' ) ; 
  end_if; 
End_Action ; 

 
Win-GRAF PAC 

 

Every period time (e.g., 5 sec), put the  
data to be sent into array (Type: BYTE)  
and send data by Function COM_send. 

 
Device 

 

Check if receive the complete  
and correct data? 

And then do proper operations. 
   

Port_OK  ; 

Action(P) : 

  (* prepare ByeAry[] to be sent *) 

  (* ... *) 

  (* Send it, here send 20 bytes *) 

  TMP_DINT := COM_send(Port_number , ByteAry , 0, 20) ; 

End_Action ; 

GS3.T >= T#5s ; 

1 

2 

3 

4 

1 

(Open COM2 as `19200,E,8,2‘) 

(If succeeds, do the next.) 

(The sent data concers with 

your application, please 

use COM_send to send 

data after the data is 

ready. Max. 500 Bytes ) 

(If wants to send String, can use the Function 

COM_send_str(). Max. 255 Bytes, and can not 

has "0" in the Byte of the String, because "0" 

means the end of the String, but it can be the 

Character `0‘.) 

(After 5 seconds, 

return to the step 1 to 

send the next data.) 



Win-GRAF User Manual,  V 1.00,  Jul. 2014  by ICP DAS     12-14 

 

12.3 Read/Write Data from/to a File in The PAC 

The Win-GRAF Workbench provides the following Functions to enable sequential read/write operations 

in disk files of the Win-GRAF PAC. 

 

Functions Descriptions 

Please click the menu bar  "Help" > "Topics"  and type 
the searching key word “File” to see more detail 
information in the topic of the “File Management 
functions”. 

 

F_ROPEN Open a file for reading. 

F_WOPEN Create or reset a file and open it for writing. 

F_AOPEN Create or open a file in append mode. 

F_CLOSE Close an open file. 

F_EOF Test if the end of file is reached in a file open for read. 

FA_READ Read a DINT integer from a binary file. 

FA_WRITE Write a DINT integer to a binary file. 

FM_READ Read a STRING value from a text file 

FM_WRITE Write a STRING value to a text file. 

FB_READ Read binary data from a file. 

FB_WRITE Write binary data to a file. 

F_EXIST Test if a file exists. 

F_GETSIZE Get the size of a file. 

F_COPY Copy a file. 

F_DELETE Remove a file. 

F_RENAME Rename a file. 

Refer  Section 1.2.3 to find the detailed descriptions for the following Functions. 

F_dir Create a directory. 

F_cp_dir 
Copy all files in a directory to another directory (exclude files 
in sub-directories). 

F_del_dir 
Delete a directory and all files inside it (exclude 
sub-directories and files inside sub-directories). 

 
Note:  The Win-GRAF PAC of ICP DAS does not support Functions “F_SAVERETAIN” and 

“F_LOADERETAIN”. 
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12.3.1 Write Data to a File in the PAC 
 

Refer P12-1 to open the project ("demo_file1.zip"), and can view/add variables in the variable area. 
 
ST Program:   This program can be used to write 10 "REAL" values to a file in the PAC. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

(*  This "demo_file1" project will save 10 REAL value to a file  

in the  \System_Disk\Real_data1.txt . 

 

File Format : 

    Each row contains one REAL value and ends with <CR><LF> characters.  Like: 

 

    1.08 

    2.786 

    38.45 

    41.5 

    59.875 

    60.76 

    71.23 

    80.5 

    99.8 

    100.7           *) 
 

 (*  Variables declaration: 

       Write_File         : BOOL  

       Tmp_string       : String, len=255 

       File_ID               : DINT 

       REAL_val[0..9] : REAL    

       ii                         : DINT 

       File_Status       : String, len=128    *) 

  

 (* Set Write_File as TRUE to write data to the file *) 

 if  Write_File  then 

      

    Write_File := FALSE ; 

    File_ID := F_Wopen( '\System_Disk\Real_data1.txt' );    

 

   if  File_ID = 0  then 

       (* Can not open file in write mode *) 

       File_Status := 'Can not open file in write mode !' ; 

    else 

(* open file in write mode ok, save REAL[0] ~ [9] to file , 
         each row contains 1 REAL value and end with <CR><LF> *) 

       File_Status := 'Open file ok.' ; 

       for ii := 0 to 9  by 1  do 

Because the size of \System_Disk\  is small, 
recommend you may change the directory 
to below (Depends on your application): 
 

WP-8xx8, WP-5xx8, VP-25W8, VP-4138:  
  \Micro_SD\    or 
 

XP-8x48, XP-8x48-CE6, XP-8x48-Atom-CE6: 
   \System_Disk2\ 
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Test Program:   
In this example, when the "Write_File" is set to "TRUE", the values will be written into the file 
\System_Disk\Real_data1.txt  in the PAC.  
 
1. Please set up IP configurations (Refer P12-1), compile and download the program to the PAC.  

(Click on "Project" > "Build All Projects" / "On Line", if not familiar with the operation, refer to  
Section 2.3.4 , Section 2.3.5)  
 

2. Click "NewSpy1" to open a Spy List and fill in the values to be written, and then set the "Write_File" 
become "TRUE" to write the data. (If OK, "File_Status" will show "Open file ok".) 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
3. In the PAC, open the file "Real_data1.txt", can see the values filled in the step 2. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

1.1 1.2 

2.1 
2.3 

2.2 

          Tmp_string := Any_to_string( REAL_val[ii] ) ; 

          FM_write( File_ID , Tmp_string ) ; 

       end_for ; 
        
       (* close the file *) 

       F_close( File_ID ) ; 
        
    end_if ;     

 end_if ;    

If want to save data to Integer, use the code: 

Tmp_string := Any_to_string( DINT_val[ii] ) ; 

and declare Variable “DINT_val” as DINT and 

Dim. at least "10" for this example. 
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12.3.2 Read Data from a File in the PAC 
 

Refer P12-1 to open the project ("demo_file2.zip"), and can view/add variables in the variable area. 
 
ST Program:   This program can be used to read 10 "REAL" values from a file in the PAC. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

(*    this "demo_file2" project will read 10 REAL value from a file  
  in the  \System_Disk\Real_data2.txt . 

File format : 
    Each row contains one REAL value and ends with <CR><LF> characters. Like: 
    1.08 
    2.786 
    38.45 
    41.5 
    59.875 
    60.76 
    71.23 
    80.5 
    99.8 
    100.7 

*) 
    

 (*  
   Variables Declaration: 
   Write_File         : BOOL  
   Tmp_string       : String, len=255 
   File_ID               : DINT 
   REAL_val[0..9] : REAL    
   ii                         : DINT 
   File_path          : String, len = 128, initial val = '\System_Disk\Real_data2.txt' 
   File_Status       : String, len=128 
 *) 
  
 (* Set Read_File as TRUE to read data from the file *) 

if  Read_File  then 
      
    Read_File := FALSE ;  
    (* Check if file exists *) 

    if  F_exist( File_path ) = FALSE  then 
        (* file doesn't exist *) 

        File_Status := 'File "' + File_path +'" does not exist !' ; 
    else 
         

(* file does exist , open it in read mode *) 

       File_ID := F_Ropen( File_path ); 
    
       if  File_ID = 0  then   
           (* open file in read mode fail *) 

           File_status := 'Can not open File "' + File_path +'" !' ; 
       else   
 

Because the size of  \System_Disk\  
is small, recommend you amy 
change the directory to below 
(Depends on your application): 
 

WinPAC, ViewPAC Series: 
  \Micro_SD\    or 
 

XP PAC Series: 
   \System_Disk2\ 
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Note:  In this example, when the "Read_File" is set to "TRUE", it will read the file in the PAC 

"\System_Disk\Real_data2.txt", please make sure the file already exists in the PAC. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

          (* open file in read mode ok, read REAL[0] ~ [9] from file , 
                each row contains 1 REAL value and end with <CR><LF> *) 

          File_status := 'Open File "' + File_path +'" Ok .' ; 
          for ii := 0 to 9  by 1  do 
              
             (*  test if the end of file is reached in a file open for read *) 

             if  F_EOF( File_ID )  then       
                (* reach the end of file, exit "for loop" *) 

                exit ; 
             end_if ; 
               
             (* read one row in the file as a string *)        
             Tmp_string := FM_READ( File_ID ) ;  
              
             (* convert the string to become REAL value *) 

             REAL_val[ii] := Any_to_REAL( Tmp_string ) ; 
              
          end_for ; 
        
          (* close the file *) 

          F_close( File_ID ) ; 
           
       end_if ;        
    end_if ;     
 end_if ;  

If want to read Integer, use the code below: 
DINT_val[ii] := Any_to_DINT( Tmp_string ) ; 
and declare Variable “DINT_val” as DINT and 
Dim. at least "10" for this example.. 
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Test Program: 
 
1. Please set up IP configurations (Refer P12-1), compile and download the program to the PAC.  

(Click on "Project" > "Build All Projects" / "On Line", if not familiar with the operation, refer to  

Section 2.3.4 , Section 2.3.5)  

 

2. Click "NewSpy1" to open a Spy List and set the "Read_File" to "TRUE" to read the data. (If OK, 

"File_Status" will show "Open File "\System_Disk\Real_data2.txt" Ok.") 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Note:  There is one another file operation example listed in the Section 6.2. It handles many data in the 

file, you may refer it. 

 

1.1 1.2 

2.1 
2.2 

2.3 
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Chapter 13 VB.net 2008 Program Running in WP-8xx8 Access to 
Win-GRAF Variables 

This chapter lists the procedure for creating the first demo program by Visual Studio .NET 2008 

development tool. There are some sample programs in the WP-8xx8 CD-ROM. 

VB .NET example: 

CD-ROM : \napdos\Win-GRAF\demo-project\vb.net_2008_demo\ 

demo_vb01 :  Digital I/O demo with one I-87055W in slot 0 of the WP-8xx8.  

demo_vb02 :  Analog I/O demo with one I-87024W in slot 1, one I-8017HW in slot 2. 

demo_vb03 :  Read/Write Win-GRAF internal integers, timers & real variables. (No I/O) 

demo_vb04 :  Read/Write Win-GRAF internal String variables. (No I/O) 
  

Win-GRAF example:  

CD-ROM : \napdos\Win-GRAF\demo-project\ 

"demo_vb01.zip",  "demo_vb02.zip",  "demo_vb03.zip",  "demo_vb04.zip"  

 

13.1 Add an Existing Win-GRAF Project from a ZIP 

Please follow these steps to restore the Win-GRAF project. 

First Click “File” -> “Add Exiting Project” -> “FromZip…”. Then choose the Win-GRAF project zip file which 

you would like to restore. After restoring the project, you have to build the project, and then download 

it to the PAC. 
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13.2 Publishing the Win-GRAF Variable for .NET 

If users wish to use .NET program to Read/Write the Win-GRAF variables. Except for String variable all of 

the variables need to use the "Open Binding Configuration" function to set an address. The following 

demonstrates how to publish Win-GRAF variable: 

 

1. Click “Open Binding Configuration” on the toolbar to open the “Binding” setup window.  

2. Click "PUBLIC (:9000)". Then users can modify the “Name” value. But keep the "Address" value is 

blank and "Port" value is fixed to 9000. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

3. Before publishing these variables, make sure you have declared them in the Variables Area. Click 

“Global variables” and press the “Ins” key to insert a new variable. The following table demonstrates  

variables using in the “Test_3” project and you can declare them according to the needs of your 

application.  

 

Variable name Type 

Public_BOOL BOOL 

Public_INT INT 

Public_DINT DINT 

Public_WORD WORD 

Public_REAL REAL 

 
 
 

4. As the figure below, click on "PUBLIC(:9000)" and drag all the needed variables to the "Name" area. 

The "Identifier" will generate an address number automatically. If any other VB or .NET program 

wants to use these public variables, it must set to the same address number (ID). 

 

NOTE: 
 The "PUBLIC" allows to use up to 8192 variables, and the "Identifier" number JUST can be 1 to 8192. 

 
 

Variable Area 
Keep "PUBLIC" value blank. 

Open Binding Configuration 
 

Enter key 
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The following procedure will show you how to use the “pub_string” function to publish the Win-GRAF 

String variable in the ST program. 
 

Syntax:  
 

 
 
 
Address:     The public address number, and its range can be 1 to 1024 

String_val: The name of String variable. 

 
Variables description: 
 

Name Type Description 

Init BOOL Set the initial value as TRUE. 

Tmp_val BOOL 
TRUE:  Binding succeeds. 
FALSE: Binding fails. 

msg1 STRING, Length is 100 
String variable for demo purpose. 
NOTE:  The String length could be 1 to 255. 

msg2 STRING, Length is 32 

msg3 STRING, Length is 60 

 
ST program: 
 
 
 
 
 
 
 
 
 
 
 

If  init  then 
  Init := false; 
(*add address 1 for share string val *) 

  Tmp_val := pub_string(1,msg1); 
 

(*add address 2 for share string val *) 
  Tmp_val := pub_string(2,msg2); 
 

(*add address 3 for share string val *) 
  Tmp_val := pub_string(3,msg3); 
 

End_if; 
 

Pub_string(Address, String_val) ; 
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13.3 Create a new VB.NET project 

1. First, run Microsoft Visual Studio .NET 2008 software, and then choose “File” > “New Project”. 

 
 
 
 
 
 
 
 
 
2. Click “Smart Device” on the left, and then select “.NET Framework 3.5” and “Smart Device Project”. 

Entering a proper project name and click “OK”. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

3. Select the "Device Application" and "Windows CE" and “.NET Compact Framework Version 3.5”, then 

click “OK”. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

1 

2 

3 

1 

2 
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13.3.1 Add Project Reference 

The “UserShareNet.dll” library contains all functions of data exchange with Win-GRAF variables. Before 

you use the “UserShareNet” keyword in the program, you must add the “UserShareNet.dll” into the 

reference list of your application.   

 
1. Copy the “UserShareNet.DLL” from Win-PAC’s shipment CD (\napdos\Win-GRAF\WP-8xx8\ 

vb.net_2008_demo\wp_vb01\vb01\) to your project folder (e.g., “C:\project1\”) 

 
2. Right click on the project name (e.g., “project1”) in the 

“Solution Explorer” window, and then select “Add 

Reference …”. 

 
 
 
 
 
 
 
 
 
 
 
 
3. Click the “Browse” tab and select the “UserShareNet.dll” from your project location. 

 
 

 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 

Note:  You may copy the “UserShareNet.dll” from the CD-ROM to your current project path first. 
Then add it to the project reference. 

 
 
 
 
 
 

The current project is located in  "C:\project1". 

Right click 
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4. When “UserShareNet.dll” is added, please double click on “My Project” to check if the 

“UserShareNet.dll” is well added. 

 
 
 
 
 
 
 
 
 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

5. Right-click on the “Form1.vb” and select “View Code” from the pop-up. Move cursor to top and 

insert the “Option Explicit On” and “Imports UserShareNet” in the first two statements. 

 
 
 
 
 
 
 
 
 
 
 
 
 

Then you can design all required objects and actions inside your VB Forms.  
(Refer the Chapter 13.5 for more information about using functions in the “UserShareNet.dll”.) 

 
 
 
 
 

Right 
Click 

Double click 
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13.4 Compiling the Application 

When you have finished writing a program, you can build(compile) an application by the following steps. 

 
1. Remember to save at any time for safety. 

 
  
 
 
 
 
 
 
2. Then compile (Build) the project. The result is listed in the “Error List” windows at the bottom. 

 
 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
3. You can find the execution file in 

 
 
 
 
Please copy this execution file to the WP-8xx8’s \System_Disk\Win-GRAF\ path to run it. 
 
 

Note:  

User may copy the VB.net execution file to other path to run it but there should contain at least two 

DLL files with it or it cannot run correctly. 

 

For ex, the project1.exe can run in the \Micro_SD\ path if there is three files in it. The  

“project1.exe” , “UserShareNet.dll” and “Quicker.dll”  . (The “UserShareNet.dll” and “Quicker.dll” 

can be copied from the Win-GRAF PAC’s “\System_disk\Win-GRAF\” path) 

 
 
 
 
 

<Your VB.net Project folder> \bin\Release\ <project_name>.exe 
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13.5 UserShareNet.dll 

This section we will focus on the description of the application example of UserShareNet.dll functions. 

There are some functions that can be used to Read/Write data from/to the Win-GRAF soft-logic. The 

functions of UserShareNet.dll can be divided into as listed below: 

 

1. R/W Boolean 
2. R/W 8-bit Integer 
3. R/W 16-bit Integer 
4. R/W 32-bit Integer 
5. R/W 64-bit Integer 
6. R/W 32-bit Float 
7. R/W 64-bit Float 
8. R/W String 

※ Refer the “Appendix A” to get familiar with the definition of Win-GRAF variables. 

 
 

13.5.1 R/W Boolean Functions   

  
■ Set_BOOL 

 
Description:  

This function is to set a value to a Win-GRAF Boolean variable. 

 

Syntax:  

UserShare.Set_BOOL ( iUserAddress  As System.UInt16 , ByVal iStatus As byte) as Byte 

 

Parameter:  

iUserAddress :  Address of the Variable (1 to 8192) 

iStatus :  Set the status. For instance, iStatus = 1 for True, iStatus = 0 for False 

 

Example:  

‘Set the Win-GRAF BOOL variable with address 1 to True. 

UserShare.Set_BOOL(Convert.ToUInt16(1), 1) 

 

Demo program : 

CD-ROM:   \napdos\Win-GRAF\demo-project\vb.net_2008_demo\demo_vb01 
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■ Get_BOOL 

 
Description:  

This function is to get the value from a Win-GRAF BOOL variable. 

 

Syntax:  

UserShare.Get_BOOL ( iUserAddress As System.UInt16 , ByRef iStatus As byte)  

 

Parameter:  

iUserAddress :  Address of the Variable (1 to 8192) 

iStatus :  Get the variable value , iStatus = 1 for True, iStatus = 0 for False 

 

範例:  

‘Get the value of Win-GRAF BOOL variable with address 1. 

Dim iStatus As Byte  

UserShare.Get_BOOL(Convert.ToUInt16(1), iStatus)  

 

 

Demo Program : 

CD-ROM:  \napdos\Win-GRAF\demo-project\vb.net_2008_demo\demo_vb01 

 

 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



Win-GRAF User Manual,  V 1.00,  Jul. 2014  by ICP DAS     13-10 

 

13.5.2 Integer R/W Functions 

 

■  Set_SINT    ■  Set_INT    ■  Set_DINT    ■  Set_LINT 

 

Description:  

These functions are to set 8-bit Integer, 16-bit Integer, 32-bit integer & 64-bit Integer value to Win-GRAF 

integer variables. 

 
Syntax:  

UserShare.Set_SINT (ByVal iUserAddress As System.UInt16 , ByVal iStatus As SByte) As Byte 
 
UserShare.Set_INT (ByVal iUserAddress As System.UInt16 , ByVal iStatus As Short) As Byte 
 

UserShare.Set_DINT (ByVal iUserAddress As System.UInt16 , ByVal iStatus As Integer) As Byte 
 

UserShare.Set_LINT (ByVal iUserAddress As System.UInt16 , ByVal iStatus As long) As Byte 

 
Parameter:  

iUserAddress : Address of Variable. (1 to 8192) 

iStatus : the value of 8-bit Integer, 16-bit Integer, 32-bit Integer or 64-bit Integer. 

 
Example:  
‘Set a 32-bit integer value “1234567” to the Win-GRAF DINT variable with Address “1”. 

UserShare.Set_DINT(Convert.ToUInt16(1), Convert.ToInt32(1234567) )    
 

‘Set a 16-bit integer value “-1234” to the Win-GRAF INT variable with Address “2”. 

UserShare.Set_INT(Convert.ToUInt16(3), Convert.ToInt16(-1234) )    
 

‘Set a 64-bit Integer value “123456789012345” to the Win-GRAF LINT variable with Address “3”. 

UserShare.Set_LINT(Convert.ToUInt16(3), Convert.ToInt64(123456789012345) )    
 

 ‘Set a 8-bit Integer value “125” to the Win-GRAF SINT variable with Address “4”. 

UserShare.Set_SINT(Convert.ToUInt16(3), Convert.ToSByte(125) )    

 

Demo Program :   

CD-ROM :   

1. \napdos\Win-GRAF\demo-project\vb.net_2008_demo\demo_vb02 for R/W analog I/O 

2. \napdos\Win-GRAF\demo-project\vb.net_2008_demo\demo_vb03 for R/W internal long integer, 

Timer and Real (floating-point) values.  

 

 

 

 

 

 

 



Win-GRAF User Manual,  V 1.00,  Jul. 2014  by ICP DAS     13-11 

 

■  Get_SINT    ■  Get_INT    ■  Get_DINT    ■  Get_LINT 

 
Description:  

These functions are to get 8-bit integer, 16-bit integer, 32-bit integer & 64-bit integer value from 

Win-GRAF integer variables. 

 
Syntax:  

UserShare. Get_SINT (ByVal iUserAddress As System.UInt16 , ByRef iStatus As SByte) As Byte 
 
UserShare. Get_INT (ByVal iUserAddress As System.UInt16 , ByRef iStatus As Short) As Byte 
 
UserShare.Get_DINT (ByVal iUserAddress As System.UInt16 , ByRef iStatus As Integer) As Byte 
 
UserShare. Get_LINT (ByVal iUserAddress As System.UInt16 , ByRef iStatus As long) As Byte 

 
Parameter:  

iUserAddress :  Address of Variable (1 to 8192) 

iStatus :  Get the 8-bit integer, 16-bit integer, 32bit-integer or 64-bit integer value. 

  

Example:  

Dim Dlong_val As Int64 

Dim short_val As Int16 

Dim long_val As Int32 

Dim Sbyte_val as byte 

 

‘Get 64-bit integer value from the Win-GRAF LINT variable with address “7”. 

UserShare.Get_LINT(Convert.ToUInt16(7), Dlong_val)  
 

‘Get 32-bit integer value from the Win-GRAF DINT variable with address “8”. 

UserShare.Get_DINT(Convert.ToUInt16(8), long_val)  
 

‘Get 16-bit integer value from the Win-GRAF INT variable with address “9”. 

UserShare.Get_INT(Convert.ToUInt16(9), short_val)  
 

‘Get 8-bit integer value from the Win-GRAF SINT variable with address “10”. 

UserShare.Get_SINT(Convert.ToUInt16(9), sbyte_val)  

 

Demo program:  

CD-ROM:   

1. R/W analog I/O :  

\napdos\Win-GRAF\demo-project\vb.net_2008_demo \demo_vb02 

2. R/W internal long integer, Timer and Real (floating-point) values : 

\napdos\Win-GRAF\demo-project\vb.net_2008_demo\demo_vb03 
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13.5.3 R/W Real variable Functions 

 
■  Get_REAL    ■  Get_LREAL  

 
Description:  

These functions are to get 32-bit REAL and 64-bit double from the Win-GRAF REAL/LREAL variable. 

 
Syntax:  

UserShare. Get_REAL (ByVal iUserAddress As System.UInt16 , ByRef iStatus As Single) As Byte 
 
UserShare. Get_LREAL(ByVal iUserAddress As System.UInt16 , ByRef iStatus As Double) As Byte 

 
parameter:  

iUserAddress :  Address of Variable (1 to 8192) 

iStatus :  Get the 32-bit REAL or 64-bit double value. 

  

example:  

Dim float_val As Single 

Dim double_val As Double 

 

‘Get 64-bit double value from the Win-GRAF LREAL variable with address “7”. 

UserShare.Get_LREAL(Convert.ToUInt16(7), double_val)  

 

‘Get 32-bit REAL value from the Win-GRAF REAL variable with Address “8”. 

UserShare.Get_REAL(Convert.ToUInt16(8), float_val)  

 

Demo program:  

CD-ROM:   

1. R/W analog I/O :  

\napdos\Win-GRAF\demo-project\vb.net_2008_demo\demo_vb02 

2. R/W internal long integer, Timer and Real (floating-point) values : 

\napdos\Win-GRAF\demo-project\vb.net_2008_demo\demo_vb03 
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■  Set_REAL    ■  Set_LREAL  

 
Description:  

These functions are to set 32-bit REAL and 64-bit double value to the Win-GRAF REAL/LREAL variable. 

 
Syntax:  

UserShare. Set_REAL (ByVal iUserAddress As System.UInt16, ByVal iStatus As Single) As Byte 
 
UserShare. Set_LREAL(ByVal iUserAddress As System.UInt16, ByVal iStatus As Double) As Byte 

 
Parameter:  

iUserAddress :  Address of Variable. (1 to 8192) 

iStatus :  Set the 32-bit REAL or 64-bit double. 

  
Example:  

‘Set a 64-bit double value “11234.234567” to the Win-GRAF LREAL variable with address “1”. 

UserShare.Set_LREAL(Convert.ToUInt16(7),Convert.ToDouble(11234.234567))  

 

‘Set a 32-bit REAL value “123.12” to the Win-GRAF REAL variable with Address “8”. 

UserShare.Set_REAL(Convert.ToUInt16(8), Convert.ToSingle (123.12))  

 

Demo program:  

CD-ROM:   

1. R/W analog I/O : \napdos\Win-GRAF\demo-project\vb.net_2008_demo\demo_vb02 

2. R/W internal long integer, Timer and Real (floating-point) values : 

\napdos\Win-GRAF\demo-project\vb.net_2008_demo\demo_vb03 
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13.5.4 R/W String variable Functions 

 

■  Get_STRING  

 
Description:  

This function is to get a Win-GRAF String variable. 

 
Syntax:  

UserShare. Get_STRING (ByVal iUserAddress As System.UInt16, ByVal msg() As Byte) As Byte 

 
Parameter:  

iUserAddress :  Address of Variable (1 to 1024) 

msg() :  Get the string value. 

  

Example: 

Dim str_val As String 

Dim msg() As Byte 

 

‘Get String value of the Win-GRAF String variable with address “7”. 

UserShare.Get_STRING(Convert.ToUInt16(7),msg )  

str_val= byte_array_to_unicode(msg) 

 

 Private Function byte_array_to_unicode(ByVal buf() As Byte) As String 

       Dim tmpmsg As String 

       If buf.Length > 255 Then 

           Return Nothing 

       End If 

tmpmsg = System.Text.Encoding.GetEncoding("UTF-8").GetString(buf, 0,  buf.Length) 

 

       Return tmpmsg 

   End Function 

 

Demo program:  

CD-ROM:   

1. R/W String variable:  

\napdos\Win-GRAF\demo-project\vb.net_2008_demo\demo_vb04 
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■  Set_STRING  

 
Description:  

This functions is to set String value to the Win-GRAF String variable. 

 
Syntax:  

UserShare. Set_STRING (ByVal iUserAddress As System.UInt16, ByVal msg() As Byte) As Byte 

 
Parameter:  

iUserAddress : Address of Variable. (1 to 1024) 

msg() : the string value. 

  
Example:  

Dim str_val As String=”Hello World” 

Dim msg() As Byte 

 

msg= unicode_to_byte_array(str_val) 

 

‘Set a string value “Hello World” to the Win-GRAF String variable with Address “7”. 

UserShare.Set_STRING(Convert.ToUInt16(7),msg )  

 

‘Convert String to byte array. 

Private Function unicode_to_byte_array(ByVal msg As String) As Byte() 

       Dim tmpbuf() As Byte 

       If msg.Length > 255 Then 

           Return Nothing 

       End If 

       tmpbuf = System.Text.Encoding.GetEncoding("UTF-8").GetBytes(msg) 

       Return tmpbuf 

End_Function 

 

Demo program:  

CD-ROM:   

1. R/W String variable : 

\napdos\Win-GRAF\demo-project\vb.net_2008_demo\demo_vb04 
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13.5.5 How to use VB.NET R/W to Win-GRAF String variable 

 
Before .NET program write to Win-GRAF String variable. The String-type has to convert to byte array. If 
you need to read Win-GRAF String variable. Then you have to convert byte array to String. There is an 
VB.NET example to show how to convert each other. 

 (Encode :UTF-8 )： 

 
Convert String to byte array 
   Private Function unicode_to_byte_array(ByVal msg As String) As Byte() 
       Dim tmpbuf() As Byte 
       If msg.Length > 255 Then 
           Return Nothing 
       End If 
 
       tmpbuf = System.Text.Encoding.GetEncoding("UTF-8").GetBytes(msg) 
       Return tmpbuf 
   End Function 
 
Convert byte array to string 
   Private Function byte_array_to_unicode(ByVal buf() As Byte) As String 
       Dim tmpmsg As String 
       If buf.Length > 255 Then 
           Return Nothing 
       End If 
tmpmsg = System.Text.Encoding.GetEncoding("UTF-8").GetString(buf, 0, buf.Length) 
 
       Return tmpmsg 
   End Function 
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Chapter 14 C# .net 2008 Program Running In WP-8xx8 Access To 
Win-GRAF Variables 

This chapter lists the procedure for creating the first demo program by Visual Studio .NET 2008 

development tool. There is some sample programs in the Wp-8xx8 CD-ROM. 
 

C# demo: 

CD-ROM : \napdos\Win-GRAF\demo-project\CSharp.net_2008_demo\ 

demo_CSharp01 :  Digital I/O demo with one I-87055W in slot 0 of the Wp-8xx8. 

demo_CSharp02 :  Analog I/O demo with one I-87024W in slot 1 and one I-8017HW in slot 2. 

demo_CSharp03 :  Read / Write Win-GRAF internal integers, timers and real variables. (No I/O) 

demo_CSharp04 :  Read/Write Win-GRAF internal String variables. (No I/O) 
  

Win-GRAF demo:  

CD-Rom : \napdos\Win-GRAF\demo-project\ 

"demo_vb01.zip",  "demo_vb02.zip",  "demo_vb03.zip",  "demo_vb04.zip"  

 

 

14.1 Add  an Existing Win-GRAF project from a ZIP 

Please refer the Chapter 13.1 

 
 

14.2 Publishing the Win-GRAF Variable for .NET 

Please refer the Chapter 13.2  

 
 

14.3 Create a New C# Project 
 

1. First, users need to open Microsoft Visual Studio .NET 2008 software. And then in the menu of “File”, 
please run the “New Project” . 
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2. Check the “Smart Device” on the left, then selecting the “.NET framework 3.5” and “Smart Device 

Project”. Then entering a proper project name and the last click on “OK”. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
3. Select the "Device Application" and "Windows CE" and “.NET Compact Framework Version 3.5”, 

then click on “OK”. 
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14.3.1 Add C# Project Reference 

The “UserShareNet” library contains all modules’ functions. Before you use the “UserShare” keyword in 

the program, you must add the “UserShareNet.dll” into the reference list of your application. 

 

1. Copy the “UserShareNet.DLL” from WP-8xx8 CD-ROM: 

\napdos\Win-GRAF\WP-8xx8\CSharp.net_2008_demo\demo_CSharp01\ to your project folder(ex: 

C:\project1\) 

 

2. Right click on the Project name on the right 

hand side , then select “Add Reference …” 

 

 
 
 
 
 
 
 
 

 
 
 
 
3. Click the “Browse” button. Select the “UserShareNet.dll” from your project location. 

 
 

 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 

Note:  You may copy the “UserShareNet.dll” from the CD-ROM to your current project path first. 

Then add it to the project reference. 

 

 
 
 
 
 

Right Click 

Change folder to your current project Path. 
(Ex: "C:\project1") 
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4. When “UserShareNet.dll” are added, you can see them in the solution explorer as below. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

5. Right-click on the “Form1.cs” and select “View Code” from the pop-up. Move cursor to top and 

insert the “using UserShareNet;” in the first statements.   

 

 
 
 
 
 
 
 
 
 
 

Then you can design all required objects and actions inside your C# Forms.  

(Refer the Section 14.5 for more information about using functions in the “UserShareNet.dll”.) 
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14.4 Compiling the Application Program 

When you have finished writing a program, you can build(compile) an application by the following steps. 

 

1. Remember to save at any time for safety. 

 
  
 
 
 
 
 
 
2. Then compile (Build) the project . The result is listed in the “Error List” windows at the bottom . 

 
 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
3. You can find the execution file in 

 

 

 

 

Please copy this execution file to the Wp-8xx8’s \System_Disk\Win-GRAF\ path to run it. 

 
 

Note:  

User may copy the C#.net execution file to other path to run it but there should contain at least two DLL 

files with it or it can not run correctly. For ex, the project1.exe can run in the \Micro_SD\ path if there is 

three files in it. The “project1.exe”, “UserShareNet.dll” and, “Quicker.dll” .  

(The “UserShareNet.dll” and “Quicker.dll” can be copied from the Win-GRAF PAC’s 

“\System_disk\Win-GRAF\” path) 

 

 
 

<Your C# .net Project folder> \bin\Release\ <project_name>.exe 
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14.5 UserShareNet.DLL 

This section we will focus on the description of the application example of UserShareNet.DLL 

functions. There are some functions that can be used to Read/Write data from/to the Win-GRAF 

variable. The functions of UserShareNet.DLL can be divided into as listed below 

 

1. R/W Boolean 

2. R/W 8-bit Integer 

3. R/W 16-bit Integer 

4. R/W 32-bit Integer 

5. R/W 64-bit Integer 

6. R/W 32-bit Float 

7. R/W 64-bit Float 

8. R/W 32-bit String 

 

※ Refer the “Appendix A” to get familiar with the definition of Win-GRAF variables. 
 
 

14.5.1 R/W Boolean Functions 

  
■Set_BOOL 

 
Description : 

This function is to set a value to a Win-GRAF Boolean variable. 

 

Syntax: 

 

 

 

Parameter:  

iUserAddress :  Address of Variable (1 to 8192) 

iStatus :  Set the status. For instance, iStatus = 1 for True, iStatus = 0 for False 

 

Example:  

// Set the Win-GRAF BOOL variable with address 1 to True.  

 UserShare.Set_BOOL(Convert.ToUInt16(1), 1);  

 

Demo program : 

CD-ROM : \napdos\Win-GRAF\demo-project\CSharp.net_2008_demo\demo_CSharp01 

 

 

 

 

 

 

 

UserShare.Set_BOOL(ushort iUserAddress, byte iStatus) 
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■Get_BOOL 

 
Description : 

This function is to get the value from a Win-GRAF BOOL variable. 

 

Syntax:  

 

 

 

 

Parameter:  

iUserAddress :  Address of Variable. (1 to 8191) 

iStatus : Get the variable status , iStatus = 1 for True, iStatus = 0 for False. 

 

Example::  

Byte iStatus=0; 

// Get the value of Win-GRAF BOOL variable with address 1.   

UserShare.Get_BOOL(Convert.ToUInt16(1),out iStatus);  

 

Demo program : 

CD-ROM: \napdos\Win-GRAF\demo-project\CSharp.net_2008_demo\demo_CSharp01 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

UserShare.Get_BOOL(ushort iUserAddress, out byte iStatus) 
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14.5.2 R/W Integer Functions 

 

■  Set_SINT    ■  Set_INT    ■  Set_DINT    ■  Set_LINT 

 
Description:  

These functions are to set 8-bit Integer, 16-bit Integer, 32-bit integer & 64-bit Integer value to Win-GRAF 

integer variables. 

 

Syntax:  

 
 
 
 
 
 
 
 
 

 
Parameter:  

iUserAddress : Address of Variable. (1 to 8192) 

iStatus : Set the 8-bit Integer, 16-bit Integer, 32-bit Integer or 64-bit Integer. 

 

Example:  

// Set a 32-bit integer value “1234567” to the Win-GRAF DINT variable with Address “1”. 

int temp1=1234567; 

UserShare.Set_DINT(Convert.ToUInt16(1), temp );     
 

// Set a 16-bit integer value “-1234” to the Win-GRAF INT variable with Address “2”. 

short temp2= -1234; 

UserShare.Set_INT(Convert.ToUInt16(2), temp2 );    
 

// Set a 64-bit Integer value “123456789012345” to the Win-GRAF LINT variable with Address “3”. 

long temp3=123456789012345; 

UserShare.Set_LINT(Convert.ToUInt16(3),  temp3 );   

 

// Set a 8-bit Integer value “125” to the Win-GRAF SINT variable with Address “4”. 

Sbyte temp4=125; 

UserShare.Set_SINT(Convert.ToUInt16(4),  temp4 );    

 

Demo program:  

CD-ROM:   

1. R/W analog I/O: 

\napdos\Win-GRAF\demo-project\CSharp.net_2008_demo\demo_CSharp02 

2. R/W internal Boolean ,long integer, Timer and Real (floating-point) values : 

\napdos\Win-GRAF\demo-project\CSharp.net_2008_demo\demo_CSharp03 

  

 

UserShare.Set_SINT(ushort iUserAddress , sbyte iStatus) 
 

UserShare.Set_INT(ushort iUserAddress , short iStatus) 
 

UserShare.Set_DINT(ushort iUserAddress, int iStatus) 
 
UserShare.Set_LINT(ushort iUserAddress, long iStatus) 
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■  Get_SINT    ■  Get_INT    ■  Get_DINT    ■  Get_LINT 

 
Description:   

These functions are to get 8-bit integer, 16-bit integer, 32-bit integer & 64-bit integer value from 

Win-GRAF integer variables. 

 
Syntax:  

 

UserShare.Get_SINT(ushort iUserAddress, out sbyte iStatus) 
 
UserShare.Get_INT(ushort iUserAddress, out short iStatus) 
 
UserShare.Get_DINT(ushort iUserAddress, out int iStatus) 
 
UserShare.Get_LINT(ushort iUserAddress, out long iStatus) 
 

 
Parameter:  

iUserAddress :  Address of Variable (1 to 8192) 

iStatus :  Get the value of Win-GRAF integer variables. 

 

example:  

Int64 Dlong_val; 

Int16 short_val; 

Int32 long_val ; 

sbyte sbyte_val; 

 

// Get 64-bit integer value from the Win-GRAF LINT variable with address “7”. 

UserShare.Get_LINT(Convert.ToUInt16(7),out Dlong_val);  
 

// Get 32-bit integer value from the Win-GRAF DINT variable with address “8”. 

UserShare.Get_DINT(Convert.ToUInt16(8),out long_val);  
 

// Get 16-bit integer value from the Win-GRAF INT variable with address “9”. 

UserShare.Get_INT(Convert.ToUInt16(9),out short_val);  
 

// Get 8-bit integer value from the Win-GRAF SINT variable with address “10”. 

UserShare.Get_SINT(Convert.ToUInt16(9),out sbyte_val)  

 

Demo program:  

CD-Rom:   

1. R/W analog I/O: 

\napdos\Win-GRAF\demo-project\CSharp.net_2008_demo\demo_CSharp02 

2. R/W internal Boolean ,long integer, Timer and Real (floating-point) values: 

\napdos\Win-GRAF\demo-project\CSharp.net_2008_demo\demo_CSharp03 
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14.5.3 R/W Real variable Functions 

 
■  Get_REAL    ■  Get_LREAL  

 
Description: 

These functions are to get 32-bit REAL and 64-bit double from the Win-GRAF. 

 

Syntax:  

UserShare. Get_REAL (System.UInt16 iUserAddress, out float iStatus) 
 
UserShare. Get_LREAL(ByVal iUserAddress As System.UInt16 , out Double iStatus) 

 
Parameter:  

iUserAddress :  Address of Variable (1 to 8192) 

iStatus :  Get the 32-bit REAL or 64-bit double value. 

  
Example:  

float float_val; 

double double_val; 

 

// Get 64-bit double value from the Win-GRAF LREAL variable with address “7”. 

UserShare.Get_LREAL(Convert.ToUInt16(7),out double_val); 

 

// Get 32-bit REAL value from the Win-GRAF REAL variable with Address “8”.  

UserShare.Get_REAL(Convert.ToUInt16(8),out float_val); 

 

Demo program:  

CD-Rom:   

1. R/W analog I/O:  

\napdos\Win-GRAF\demo-project\CSharp.net_2008_demo\demo_CSharp02 

2. R/W internal long integer, Timer and Real (floating-point) values : 

\napdos\Win-GRAF\demo-project\CSharp.net_2008_demo\demo_ demo_CSharp03 
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■  Set_REAL    ■  Set_LREAL 

 
Description:  

These functions are to set 32-bit REAL and 64-bit double value to the Win-GRAF REAL/LREAL variable. 

 
Syntax:  

UserShare. Set_REAL ( ushort iUserAddress , float iStatus )  
 
UserShare. Set_LREAL( ushort iUserAddress , Double iStatus) 

 
Parameter:  

iUserAddress :  Address of Variable. (1 to 8192) 

iStatus : Set the 32-bit REAL or 64-bit double. 

 

  

Example:  

// Set a 64-bit double value “11234.234567” to the Win-GRAF LREAL variable with address “7” 

UserShare.Set_LREAL(Convert.ToUInt16(7),Convert.ToDouble(11234.234567)); 

 

// Set a 32-bit REAL value “123.12” to the Win-GRAF REAL variable with Address “2”. 

UserShare.Set_REAL(Convert.ToUInt16(8), Convert.ToSingle (123.12)); 

 

 

Demo program :  

CD-ROM:   

1. R/W analog I/O:  

\napdos\Win-GRAF\demo-project\CSharp.net_2008_demo\demo_CSharp02 

2. R/W internal long integer, Timer and Real (floating-point) values : 

\napdos\Win-GRAF\demo-project\CSharp.net_2008_demo\demo_CSharp03 
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14.5.4 R/W String variable Functions 

 

■  Set_STRING  

 
Description:  

This function is to get a Win-GRAF String variable. 

 

Syntax:  

UserShare.Set_STRING (ushort  addr , Byte []  msg)  

 

Parameter:  

addr : Address of Variable (1 to 1024) 

msg[] : Get the string value. 

  

Example:  

String str_val; 

Byte[] msg;   

 

// Get String value of the Win-GRAF String variable with address “7”. 

msg= unicode_to_byte_array(str_val); 

UserShare.Set_STRING(Convert.ToUInt16(7),msg ); 

 

//Convert String to byte array. 

private byte[] unicode_to_byte_array(string msg) 

       { 

           byte[] tmpbuf; 

           if (msg.Length > 255) 

               return null; 

 

           tmpbuf = Encoding.GetEncoding("UTF-8").GetBytes(msg); 

           return tmpbuf; 

       } 

 

 

Demo program:  

CD-Rom:   

1. R/W String variable : 

\napdos\Win-GRAF\demo-project\CSharp.net_2008_demo\demo_CSharp04 
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■  Get_STRING  

 
Description:  

This functions is to set String value to the Win-GRAF String variable. 

 
Syntax :  

UserShare.Set_STRING (ushort  addr , Byte []  msg)  

 
Parameter:  

addr : Address of Variable. (1 to 1024) 

msg[] : Set the string value. 

  

Example:  

String str_val= “Hello World”; 

Byte[] msg;   

 

// Set a string value “Hello World” to the Win-GRAF String variable with Address “7”. 

UserShare.Get_STRING(Convert.ToUInt16(7),msg ); 

str_val= byte_array_to_unicode(msg); 

 

//Convert byte array to String 

private string byte_array_to_unicode(byte[] buf) 

  { 

           string tmpmsg; 

           if (buf.Length > 255) 

               return null; 

 

           tmpmsg = Encoding.GetEncoding("UTF-8").GetString(buf, 0, buf.Length); 

           return tmpmsg; 

   } 

 

Demo program:  

CD-Rom:   

1. R/W String variable : \napdos\Win-GRAF\demo-project\CSharp.net_2008_demo\demo_CSharp04 
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14.5.5 How to use C# to convert Win-GRAF String variable 

Before .NET program write to Win-GRAF String variable. The String-type has to convert to byte array. 

(According your .NET program Encode. Ex: UTF-8) If you need to read Win-GRAF String variable. Then 

you have to convert byte array to String. There is an C# example to show how to convert each other. 

 

Example ( Encode is UTF-8): 
 
//Convert String to byte array 
private byte[] unicode_to_byte_array(string msg) 
       { 
           byte[] tmpbuf; 
           if (msg.Length > 255) 
               return null; 
 
           tmpbuf = Encoding.GetEncoding("UTF-8").GetBytes(msg); 
           return tmpbuf; 
       } 
 
//byte array to string 
private string byte_array_to_unicode(byte[] buf) 
  { 
           string tmpmsg; 
           if (buf.Length > 255) 
               return null; 
 
           tmpmsg = Encoding.GetEncoding("UTF-8").GetString(buf, 0, buf.Length); 
           return tmpmsg; 
   } 
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Chapter 15 Using Soft-GRAF HMI in the Win-GRAF PAC 

This chapter list the way to run Soft-GRAF HMI in the Win-GRAF PAC. The Soft-GRAF is a software which 

allows user to create colorful HMI. User can easily edit HMI screen by mouse dragging and dropping the 

object and run both HMI and Win-GRAF softlogic in the same Win-GRAF PAC.  
 

※Note: Please refer the ISaGRAF FAQ 146 to get more information about using Soft-GRAF. 

ISaGRAF FAQ146: 
http://www.icpdas.com/faq/isagraf/146.htm 
 

15.1 Restore the Win-GRAF project 

Please copy all demo programs into your PC. 
CD-ROM of Win-GRAF PAC: \napdos\Win-GRAF\demo-project\Soft-GRAF-demo\ 
 

Demo project for both Win-GRAF and Soft-GRAF: 

Win-GRAF demo Soft-GRAF demo Description 

demo_soft-graf01 demo01 

Demonstrate Soft-GRAF basic HMI object. 
demo_soft-graf02 demo02 

demo_soft-graf03 demo03 

demo_soft-graf04 demo04 

demo_soft-graf05 demo05 Picture and animation picture (.gif). 

demo_soft-graf06 demo06 Trend graph and gauge. 

demo_soft-graf07 demo07a demo07b Alarm  

demo_soft-graf08 demo08 Data logger 
 

You may restore the “demo_soft_graf01.zip” to your Win-GRAF workbench to get familiar with it. Then 

download to the Win-GRAF PAC. If you have no idea how to restore the Win-GRAF project. Please refer 

the Section 13.1.  

 

15.1.1 Install the Soft-GRAF Studio 

Please download the “faq146_demo.zip” from the ISaGARF FAQ146 web page. 

http://www.icpdas.com/faq/isagraf/146.htm 
 
 

 
 

After unzip the file, please copy the “Soft-GRAF Studio” folder into “D:\”. Then, it becomes 
“D:\Soft-GRAF Studio”. 

Click here to download 

http://www.icpdas.com/faq/isagraf/146.htm
http://www.icpdas.com/faq/isagraf/146.htm
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15.1.2 Download the Soft-GRAF HMI project to the Win-GRAF PAC 

Executes the “Soft-GRAF Studio.exe” from the “D:\Soft-GRAF Studio”. Then click the “open project” on 

the upper left screen. Open the “demo01.sof”. 

 
   
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Click “project” -> “IP Setting”. Setup the IP address of the Win-GRAF PAC. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Click “download” to download HMI project to the Win-GRAF PAC. If download success, you can see HMI 
on the Win-GRAF PAC screen. 
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15.2 How to develop Soft-GRAF HMI  

Before user develops Soft-GRAF HMI, users have to publish Win-GRAF project variables. Then, Soft-GRAF 

HMI could read/write the Win-GRAF variables. Please refer the Section 13.2 to get information about 

publishing Win-GRAF variables. 

 
 
 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
There is another setting in the Win-GRAF workbench before user develops Soft-GRAF HMI. User needs 

to add “Soft-GRAF” in the Win-GRAF “IO boards”. The following steps demonstrate how to add it.  

 
Click “Open I/Os” on Win-GRAF toolbar.  

 
 
 
 
Click Slot 8 or larger slot NO. (suggest value is 9) position. Then click “Select” button. Finally, mouse 

double click “Soft-GRAF” in the dialog. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

The left example shows a 

Win-GRAF variable “LED_01” 

with address “11” is published. 

If user wish to use Soft-GRAF 

to read/write this variable. 

Then user has to set “NetWork 

Address” to 11 in Soft-GRAF 

Studio object. (This Soft-GRAF 

HMI object is “g_B_Led”. ) 

Win-GRAF  

Soft-GRAF 
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After adding “I/O boards”, please compile the Win-GRAF project. Then download to the Win-GRAF PAC. 
Then users can start to develop your Soft-GRAF HMI. 
 
※Note: Please refer ISaGRAF FAQ146 chapter 1.2 to get more details about Soft-GRAF Studio. 

ISaGRAF FAQ146: 
http://www.icpdas.com/faq/isagraf/146.htm 
 
 
 

Double Click 

http://www.icpdas.com/faq/isagraf/146.htm
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Appendix A  Data types and Ranges 

Users can specify the data type of variables in the Variables Area (refer the Section 2.2.1) or in the 
Variables window (refer the Section 2.2.2). 
 
 
 
 
 
 
 
 
 
 
 
Below are the available basic data types and ranges: 
 

Data types Size in-bits Range of Values 

BOOL (*) --- TRUE, FALSE 

SINT 8-bits (Small int, signed) -128 to +127 

USINT 
8-bits (Unsigned small int) 0 to +255 

BYTE 

INT  16-bits (Int, signed) -32768 to +32767 

UINT 
16-bits (Unsigned int) 0 to +65535 

WORD  

DINT (*) 32-bits (Double int, signed) -2147483648 to +2147483647 

UDINT 
32-bits (Unsigned double int) 0 to +4294967295 

DWORD 

LINT 64-bits (Large int, signed) -263 to +(263-1) 

ULINT 
64-bits (Unsigned large int) 0 to +(264-1) 

LWORD 

REAL (*) 32-bits (Floating point) ±3.4×10-38 to ±3.4×1038 

LREAL 64-bits (Floating point) ±1.7×10-308 to ±1.7×10308 

STRING (*) A max. of 255 characters --- 

TIME (*) 32-bits T#0ms to T#23h59m59s999ms 

(*): The common used data type.  
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Appendix B  Troubleshooting while On-Line the PAC 

If the error message is showing up (as the screenshot below) after connecting to the Win-GRAF PAC, 

refer the following content to solve the problem. 

 
 The “Bad version!” error message: 

It means that the compiled version between the PC and the PAC is different. The most common 
reason is that users have modified and re-compiled the program. 

 
To solve the problem 

1. Click the “Stop application” button to stop the running program. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

2. Click the “Download” button to download the program again. 
 
 
 
 
 
 
 
 
 

3. The “RUN” message means that the program is working properly.  
 
 
 
 
 
 



Win-GRAF User Manual,  V 1.00,  Jul. 2014  by ICP DAS    AP-3 

 

 The “Communication error” error message: 

A communications failure has occurred between the PC and the PAC. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
To solve the problem 

1. Make sure your Win-GRAF PAC is started, and the network communication between the PC and the 

PAC is functioning properly. 

2. Make sure the IP setting of the Win-GRAF project is the same as the PAC IP (refer the Section 2.3.5, 

in this example, the IP address is “192.168.255.1:502”). 

3. Make sure the network communication of your PC is working.  
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Appendix C  Enable the Screen Saver of WinCE PAC 

Please set the following two items to enable the screen of WinCE PAC. 
 
1. Choose “Control Panel” > “Power” > “Schemes”, and set the “Power Scheme” as “AC Power”, set the 

“User Idle” and the “System Idle” to the same value (or set the “System Idle” value larger than the 

“User Idle” value). 

2. Then, remember to run “WinPAC Utility” > “File” > “Save and Reboot” to save the settings and auto 

reboot the PAC. 

 
Using the WP-8xx8 as an example: 

If users do not touch the screen or button until the time out (e.g., 1 minute), the WP-8xx8 will turns off 

the backlight for enabling the screen saver. Whenever users touch the screen or button, the WP-8xx8 

will turns on the backlight again. 

 

The way to disable the screen saver is to set the “User Idle” and the “System Idle” as “Never”, and then 

remember to run “WinPAC Utility” > “File” > “Save and Reboot” to save the settings and auto reboot the 

PAC. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

1 

2 
3 

3.1 

3.2 

3.3 

4 
5 
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Appendix D  Using Expansion RS-232/485/422 

The Win-GRAF PAC (See P1-1) expand more  COM port in its slot No. 0 to 7 by using following modules. 

 

 I-8112iW :  2-port Isolated RS-232 module 

 I-8114iW :  4-port Isolated RS-232 module 

 I-8114W  :  4-port RS-232 module 

 I-8142iW :  2-port Isolated RS-422/RS-485 module 

 I-8144iW :  4-port Isolated RS-422/RS-485 module 

 

Using the WP-8xx8 as an example: 

Before using these modules, please configure then by the “WinPAC Utility”. First, plug the module in the  

WP-8xx8’s slot 0  to 7 (It is better to be in slot 0 to 3), and then run the “WinPAC Utility”. 
 

 Click the “Multi-serial port wizard” tab. 

 Check the“USE COMx” option. (Note:  The Win-GRAF doesn’t support “USE MSA/MSBx”) 

 Click the “Slot scan” button, and then the current found serial-port expansion module will be listed 

on the left. (The earlier COM port setting is listed on the right if you have already set it before.)  

 Click the “Set” button to refresh the new setting like the figure below. 

 Click [File] > [Save and Reboot] to save the new setting and auto reboot the WP-8xx8. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Note:  The WP-5xx8  does not support 

XW-5xx series XW-board. 

 (This PAC can not expand COM port.) 

1 

2.2 

2 

3 

2.3 
2.1 

Select “USE COMx” option 
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After the configuration succeeds, the COM port No. for the expansion is COM6 to COM37 in the 

Win-GRAF definition. (In this case, it expands the COM6 to COM9). 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Pin Assignment: 

I-8112iW 
2-port Isolated RS-232 

I-8114iW 
4-port Isolated RS-232 

I-8114W 
4-port RS-232 

I-8142iW (2-port Isolated RS-422/485) 
RS-485 port1:  (D1+ , D1-) 
RS-485 port2:  (D2+ , D2-) 
 

RS-422 port1: (TxD1+ , TxD1-, RxD1+, RxD1-) 
RS-422 port2: (TxD2+ , TxD2-, RxD2+, RxD2-) 

I-8144iW (4-port Isolated RS-422/485) 
RS-485 port1:  (D1+ , D1-) 
RS-485 port2:  (D2+ , D2-) 
RS-485 port3:  (D3+ , D3-) 
RS-485 port4:  (D4+ , D4-) 
 

RS-422 port1: (TxD1+ , TxD1-, RxD1+, RxD1-) 
RS-422 port2: (TxD2+ , TxD2-, RxD2+, RxD2-) 
RS-422 port3: (TxD3+ , TxD3-, RxD3+, RxD3-) 
RS-422 port4: (TxD4+ , TxD4-, RxD4+, RxD4-) 

I-8142iW I-8144iW 
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